THE ANTIEEAM STAFF RIDE

An Interactive, Computer-Driven Guide
to the Battle of Antietam

BY

COLONEL CARL D. SPRINGER, IN
United States Army

DISTRIBUTION STATEMENT A: Approved for public release.
Distribution is unlimited.

USAWC CLASS OF 1992

U.S. ARMY WAR COLLEGE, CARLISLE BARRACKS, PA 17013-5050
The Antietam Staff Ride is a computer-driven guide to the battle of Antietam. It provides the user with a comprehensive, graphical picture of the major battles fought on 17 September 1862 at Sharpsburg, Maryland. It uses a simple point-and-click interface and is completely interactive. The user views the movement of military units on a series of color maps in 30 second to one minute snapshots. The battles may be viewed one frame at a time or through continuous, animated movement. When viewed one frame at a time, the user is provided with text description of actions occurring at that moment. Additionally, short audio and visual cues such as gun fire and cannon fire are presented to aid in describing the current situation. The program contains an extensive database on unit locations, movements, order of battle, and casualties. It also contains scanned color photos of key leaders and battlefield terrain. A glossary of terms is included and contains graphic depictions of regimental formations and drill, weapons, artillery, gunnery, etc. The glossary is directly linked to continued on reverse side.
19. Abstract continued

words and terms shown as italicized text. The user simply points and clicks on
the word or term to display its definition or graphic depiction. The Antietam
Staff Ride was written using the hypermedia authoring application Aldus SuperCard.1
It runs on any color Apple Macintosh computer with a hard disk and eight megabytes
of random access memory (RAM). The title Antietam Staff Ride is being registered
and the application copyrighted by the Omar Bradley Foundation, Inc. All rights
reserved.
DISCLAIMER NOTICE

THIS DOCUMENT IS BEST QUALITY AVAILABLE. THE COPY FURNISHED TO DTIC CONTAINED A SIGNIFICANT NUMBER OF PAGES WHICH DO NOT REPRODUCE LEGIBLY.
The Antietam Staff Ride®

An Interactive, Computer-Driven Guide to the Battle of Antietam

by

Colonel Carl D. Springer, IN

 Colonel Leonard Scott
 (Project Advisor)

DISTRIBUTION STATEMENT A: Approved for public release; distribution is unlimited.

15 April 1992

U.S. Army War College
Carlisle Barracks, Pennsylvania 17013
The Antietam Staff Ride® is a computer-driven guide to the battle of Antietam. It provides the user with a comprehensive, graphical picture of the major battles fought on 17 September 1862 at Sharpsburg, Maryland. It uses a simple point-and-click interface and is completely interactive. The user views the movement of military units on a series of color maps in 30 second to one minute snapshots. The battles may be viewed one frame at a time or through continuous, animated movement. When viewed one frame at a time, the user is provided with text description of actions occurring at that moment. Additionally, short audio and visual cues such as gun fire and cannon fire are presented to aid in describing the current situation. The program contains an extensive database on unit locations, movements, order of battle, and casualties. It also contains scanned color photos of key leaders and battlefield terrain. A glossary of terms is included and contains graphic depictions of regimental formations and drill, weapons, artillery gunnery, etc. The glossary is directly linked to words and terms shown as italicized text. The user simply points and clicks on the word or term to access the definition or graphic depiction. The Antietam Staff Ride was written using the hypermedia authoring application Aldus SuperCard®\textsuperscript{1}. It runs on any color Apple\textsuperscript{®} Macintosh\textsuperscript{®} computer with a hard disk and eight megabytes of random access memory (RAM). The title Antietam Staff Ride is being registered and the application copyrighted by the Omar Bradley Foundation, Inc. All rights reserved.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract</td>
<td>ii</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>iii</td>
</tr>
<tr>
<td>List of Figures</td>
<td>iv</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>General</td>
<td>4</td>
</tr>
<tr>
<td>Conclusions</td>
<td>7</td>
</tr>
<tr>
<td>Requirements and Installation</td>
<td>9</td>
</tr>
<tr>
<td>Starting The Antietam Staff Ride®</td>
<td>13</td>
</tr>
<tr>
<td>Menus and Commands</td>
<td>18</td>
</tr>
<tr>
<td>Battle Map</td>
<td>25</td>
</tr>
<tr>
<td>Battle Leaders</td>
<td>28</td>
</tr>
<tr>
<td>Order of Battle</td>
<td>29</td>
</tr>
<tr>
<td>Battle Casualties</td>
<td>31</td>
</tr>
<tr>
<td>Appendix A. SuperCard Scripts for The Antietam Staff Ride</td>
<td>32</td>
</tr>
<tr>
<td>Appendix B. Introduction to the Battle</td>
<td>81</td>
</tr>
<tr>
<td>Appendix C. Situation Brief for Hooker’s Attack</td>
<td>85</td>
</tr>
<tr>
<td>Appendix D. Animated Sequence of Hooker’s Attack</td>
<td>91</td>
</tr>
<tr>
<td>Appendix E. Order of Battle Examples</td>
<td>101</td>
</tr>
<tr>
<td>Appendix F. Map Legend</td>
<td>105</td>
</tr>
<tr>
<td>Appendix G. Disk Install Set</td>
<td>106</td>
</tr>
<tr>
<td>Notes</td>
<td>107</td>
</tr>
<tr>
<td>Bibliography</td>
<td>108</td>
</tr>
</tbody>
</table>
# Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Hypermedia on the Macintosh</td>
<td>2</td>
</tr>
<tr>
<td>2. Initial Map Scan</td>
<td>4</td>
</tr>
<tr>
<td>3. Enhanced and Colored Map</td>
<td>4</td>
</tr>
<tr>
<td>4. The Two Layers of a Card</td>
<td>5</td>
</tr>
<tr>
<td>5. Disk 1 of the Antietam Staff Ride</td>
<td>9</td>
</tr>
<tr>
<td>6. Initial Installer Dialog Box</td>
<td>10</td>
</tr>
<tr>
<td>7. Installer Dialog Box showing final install segment</td>
<td>10</td>
</tr>
<tr>
<td>8. Alert Dialog Box</td>
<td>11</td>
</tr>
<tr>
<td>9. Selection Dialog Box</td>
<td>11</td>
</tr>
<tr>
<td>10. Compact Pro Progress Dialog Box</td>
<td>12</td>
</tr>
<tr>
<td>11. Installer Dialog Box</td>
<td>12</td>
</tr>
<tr>
<td>12. Unit Data Dialog Box</td>
<td>29</td>
</tr>
<tr>
<td>13. Subordinate Unit Data Displayed</td>
<td>29</td>
</tr>
<tr>
<td>14. CSA Order of Battle</td>
<td>30</td>
</tr>
<tr>
<td>15. Summary of USA Casualties</td>
<td>31</td>
</tr>
</tbody>
</table>
The Antietam Staff Ride®
An Interactive, Computer-Driven Guide to the Battle of Antietam

Introduction

"A sower went out to sow his seed: and as he sowed, some fell along the path, and was trodden under foot, and the birds of the air devoured it. And some fell on the rock: and as it grew up, it withered away, because it had no moisture. And some fell among thorns: and the thorns grew with it and choked it. And some fell into good soil and grew, and yielded a hundred fold." 

Luke 8:4

This paper is the user's guide to the Military Studies Project titled "The Antietam Staff Ride®." The purpose of this project is to recreate the Antietam battle site and events of the battle through the use of computer-generated graphics and animation.

In the past we studied battles by reading books and analyzing terrain, unit positioning, and unit movement using maps and terrain walks. We had to visually piece a battle together based on what we read in the books, saw on the battle maps, and, if lucky, from actually walking the terrain upon which the battle was fought. The outcome of these battles resulted from a series of related events—usually occurring simultaneously. Written accounts of battles require the reader to mentally piece together a series of events described one sentence, paragraph, or chapter at a time. Some written accounts of battles do not provide any maps at all. When maps are available they are usually placed inconveniently in a book and require the reader to flip back and forth as he reads.

This project represents a new and innovative way of studying a battle. It uses the hypermedia authoring system called Aldus SuperCard to graphically present one of the Civil War's most complicated battles. This method of presenting information gives the user access to a plethora of
maps, pictures, graphs, photographs, sounds, facts, observations, interpretations, opinions, and commentaries—all at the same time. The user can navigate freely through a sea of information, creating his own pathways. "Hypermedia" is a more recent concept, based on many of the advances in computer technology over the past 30 years. Figure 1 illustrates this concept.  

Figure 1. Hypermedia on the Macintosh

We now have personal computers with more memory, calculating speed, and storage space for information than most people dreamed possible in the early days of computers. Words are a powerful way to communicate, but they aren't the only way.

The development of computer applications has always been a difficult, labor-intensive process. It usually involves two major stages. First you write the program's core, the software engine that gives your application its basic functions. Second, you create the user interface, which in the pre-Macintosh era required only 10 percent of the development time. But times have changed, and so have user's expectations. Some Macintosh developers estimate that they now spend up to half their time working on the
interface for an application and the other half working on the application's core.4

With software like SuperCard you don't have to be a trained programmer. It uses an easy-to-learn programming language called SuperTalk. Much of the vocabulary of SuperTalk reads a lot like English. This allows the developer to concentrate more on the content and user interface than on computer code.5

The technology required to produce an interactive, computer-driven military battle guide has been available for years—so why wasn't one developed before now? One reason is specialization. Historians studied history and computer scientists studied programming. The endless hours of detailed research required to understand and write about a battle left little time for the historian to learn more than basic word processing on the computer. Another reason is the lack of software tailored to narrow applications. Most commercial software tries to appeal to as broad a user spectrum as possible. Up until now, historians simply haven't had the tools to use a computer profitably.
"There are only two powers in the world, the sword and the pen: and in the end the former is always conquered by the latter."6

Napoleon I

In the next few paragraphs, I will describe how The Antietam Staff Ride was put together. I hesitate to say programmed because 50 percent of the my time was spent in reading and re-reading the accounts of the battle. Over half the remaining time was spent scanning, enhancing, and coloring the Antietam battlefield maps.

A small, hand-held scanner was used to scan the maps into the computer. The painting and drawing tools within SuperCard were used to enhance and color the maps. An initial scan of a section of map is shown in Figure 2. This same section of map enhanced and colored with SuperCard is shown in Figure 3.

The map of Antietam prepared by Brevet Brigadier General N. Michler, Major of Engineers, in 1867 was used as the base map. However, graphics representing roads, fences, orchards, woods, grass fields, cornfields, and plowed fields were based on a reprint of the Cope survey maps prepared in 1863.7 The 1867 Michler map was used as the base map because of its small scale. Too much resolution was lost when the 1863 Antietam
battlefield map was scanned and then reduced in scale. Three maps used in the introduction were scanned from maps in the *West Point Civil War Map Atlas*.8

The basic SuperCard building blocks are projects, cards, and windows. Each card in SuperCard is part of a stack of cards. All information you see in a SuperCard file, or Project, appears on cards that you view through a window. Each card has two layers. The first layer is the *card layer*. This layer contains all text, graphics, buttons, and other information that are specific to that card only. The second layer, called the *background layer* contains all the card information that is shared with other cards in the same window. The maps in The Antietam Staff Ride are placed on the *background layer*. Unit symbols, buttons, text fields, etc. are placed on the *card layer*. Figure 4 shows the two layers of a card.9

Animation or the movement of a unit is accomplished by creating a graphic representing the unit on the card layer of a card. This graphic is then copied and pasted on a new card layer. After it is pasted to the new card layer it is moved to a new location. This is repeated until the unit is in its final position.10

![Figure 4. The Two Layers of a Card](image-url)
The most difficult part of animating a battle is determining when to start a unit moving so that it will arrive at the correct location and at the correct time. This is fairly straightforward when you have only two or three brigades, but becomes extremely complicated when there are four Corps on the battlefield at the same time—each with three or more divisions. If the resolution is at the brigade level, then you could have up to 36 brigades to maneuver. And, this does not include the artillery batteries.

The Cope maps and the maps in John Priest’s *Antietam: The Soldiers’ Battle* were extremely helpful in scripting the animated battle sequences. The Cope maps show snapshots of unit locations in 15 to 30 minute intervals. Priest’s maps are based on the Cope Maps but provide much more detail.
Conclusions

"One person with a belief is equal to a force of ninety-nine who only have an interest."¹²

John Stuart Mill

The potential for applications like The Antietam Staff Ride are unlimited. Viewed prior to the actual on-the-ground staff ride, it provides an excellent preparatory study of the battle. Placed on a lightweight, notebook computer and taken on the actual staff ride, it provides a ready-reference for confirming unit locations and movements. Present-day and Civil War-era photographs of the battlefield may be viewed on site to assist in terrain orientation and appreciation. For those unable to visit the battlefield, it provides the next best thing to being there.

The computer-driven staff ride provides the means to study those battles and campaigns too difficult to study using the normal staff ride. The Battle of Atlanta and Sherman’s march to the sea could easily be recreated in a computer-driven staff ride. Air and sea campaigns could also be recreated using this technique.

We are entering a whole new era—the decade of positive change. We must change the way we develop computer software. We can no longer afford to spend months defining requirements and rewriting these requirements into governmental contract language only to have the programmer misinterpret what we wanted. A product delivered using this development system is usually difficult to learn and use because the “user” was not involved in requirements or product development.

Today, ordinary people have access to powerful, easy-to-use computer technology. Hypermedia, authoring tools like SuperCard allow the average
Macintosh user to become a full-fledged programmer. Not only is the
development time significantly reduced, but also the end product is much
more "user-friendly"—software developed by users for users. With software
like SuperCard and hardware like the Macintosh, your only limits will be
the size of your ideas and the degree of your dedication.
Requirements and Installation

Requirements. The Antietam Staff Ride's minimum requirements are any color-capable Macintosh with eight megabytes of Random Access Memory (RAM). The Antietam Staff Ride need at least 6.5 megabytes of RAM. If you are running System 7, turn off as many of your System extension as possible. You will also need a hard disk drive with at least ten megabytes of free space. Your Macintosh also needs to have System 6.05 (or higher) installed. System 7.0 or higher is highly recommended since the application uses the balloon help feature of System 7. If you do not have an up-to-date System, you can call your local Macintosh dealer—they’re licensed to give you one.

Installation. This version of The Antietam Staff Ride comes on six 800 K floppy disks. Prior to installation turn off any virus detection applications. To install the application, insert Antietam Disk 1 into your Macintosh. The window shown in Figure 5 will appear on you desktop.

![Antietam Disk 1](image)

Figure 5. Disk 1 of The Antietam Staff Ride

Double-click on the file Antietam Installer. The installer dialog box, shown in Figure 6, will appear asking you where you want to load the final segment of the archive. Click on the Eject button to eject Antietam Disk 1.
Now insert Antietam Disk 6. The final file segment of the install set will appear in the installer dialog box window as shown in Figure 7.

If the file Antietam Segment 6 is not already selected, then select it and click on the Load button. The Antietam Disk 6 containing the file Antietam
Segment 6 will be ejected. The alert dialog box shown in Figure 8 will appear asking you to reinsert the Antietam Disk 1.

![Alert Dialog Box]

Figure 8. Alert Dialog Box

After inserting the Antietam Disk 1, you will be presented with the selection dialog box shown in Figure 9.

![Select Destination Folder]

Figure 9. Selection Dialog Box

Navigate to the volume onto which you want The Antietam Staff Ride installed by clicking on the volume icon. Now navigate to the folder in which you want the application installed. In the example shown in Figure 9, the folder named Applications on the volume named Hard Disk has been selected. Now click on the Extract button and the application will begin installing. The application used to compress The Antietam Staff Ride into its install set is called Compact Pro. As Compact Pro extracts the files on the install set, it displays the progress dialog box shown in Figure 10.
When all the data has been extracted from the installer segment, Antietam Disk 1 will be ejected and the dialog box shown in Figure 11 will appear.

Insert Antietam Disk 2 and the file *Antietam Segment 2* will appear in the installer dialog box window. Select this file and click the **Load** button.
Starting The Antietam Staff Ride

Start The Antietam Staff Ride by double-clicking on its icon. The Antietam Staff Ride icon looks like this:

Antietam Staff Ride

You can also start The Antietam Staff Ride by double-clicking on one of the document icons. The Antietam Staff Ride has three types of documents: glossary, photographs, and battle maps. The Antietam Staff Ride document icons look like this:

Glossary  Photographs  Battle Maps

The opening window When you start The Antietam Staff Ride, the About window appears and a brief selection from The Battle Hymn of the Republic plays. The About window looks like this:
Once the application has loaded into memory, the Chooser dialog box appears.

**Dialog Boxes**

A dialog box can present information to you, request information from you, or both. In most cases, dialog boxes appear in response either to a command that you have chosen or to some action that you have taken. When a dialog box requests information, it does so by presenting you with options.

Four kinds of options may be found in dialog boxes:

- **Radio buttons** Within a group of options among which you may select only one, small round buttons appear before each option name. These are called radio buttons. To select or deselect a radio button, click on the round button itself or on the name of the option following the button. Only one radio button option in a set may be selected at a time: selecting any one will deselect all others. A set of radio buttons are usually physically adjacent. Several sets of radio buttons may appear in a single dialog box, but only one from each set may be selected at any one time. A radio button indicates that an option is selected when the button is filled black and is deselected when the button is empty.

- **Check boxes** Within a group of options among which you may select any number of alternatives, a small square button appears before each option name. This is a check box. To select or deselect a check box, click on the
square before the option name or directly on
the option name itself. If that option was
previously deselected, it will become selected; if
it was selected, the option will become
deselected. Multiple check boxes within a set
may be selected or deselected. A check box
indicates that an option is selected when an x is
displayed and is deselected when the box is empty.

• Option boxes An option for which you must
enter data has one or more option boxes. Most
option boxes contain default data when the
dialog box first appears. When this default data
is selected (highlighted with white characters on
a black background), you can enter new values
from the keyboard and the default data will be
replaced. To select a value in an option box,
double-click on a newly entered value or drag
over the current value. In a dialog box that
contains several option boxes, you can move
from one option box to the next by pressing the
tab key.

• Pop-up menu An option that is presented as a
pop-up menu displays only the current option
setting when its dialog box first appears. To
view the list of alternatives for such an option,
you must select the current option (or an icon in
some cases) by pressing and holding down the
mouse button on top of it. This will "pop-up" a
menu displaying the available options. An
option is selected from the pop-up menu by
dragging up or down the listing and releasing
the mouse button when the name of the desired
alternative is highlighted. If an option in a pop-
up menu is followed by an ellipsis (…), choosing it will bring up yet another dialog box, which contains additional options.

Once you have finished entering, selecting, and choosing options, you may exit a dialog box by clicking on buttons. The most common buttons are the OK and Cancel buttons. Buttons may also serve as commands when they are placed within dialog boxes, where they are used to indicate an action or bring up another dialog box.

Dialog boxes that do not request information are known as alert boxes, since their purpose is to alert you of some fact. Some alert boxes alert you of the consequences of the action you are about to take and allow you to abort that action. Others inform you of some event that has already happened, allowing you only to acknowledge that you are aware of the event.

You will notice that an option, command, or menu is sometimes dimmed. A dimmed item indicates that it has no effect on a certain situation. Dimmed items cannot be chosen or selected.

Chooser Dialog Box
The first window to appear after the About window contains the Chooser dialog box. This dialog box contains three buttons: Instructions, Introduction, and Battle Map. If you are not familiar with the Macintosh interface, click on the Instructions button and you will be presented with a tutorial on how to navigate through this application. (See Appendix A - “SuperCard Scripts for The Antietam Staff Ride” to
view the program's code.) For a description of the events leading up the battle, click on the Introduction button. (See Appendix B - "Introduction to the Battle" to view the four maps and narrative contained in the Introduction.) Once you finish the introduction, you will go to the Battle Map. To go directly to the battle map, click on the Battle Map button.

The Chooser dialog box looks like this:
Menus and Commands

The following describes the menus and commands available when the Battle Map is displayed. Keyboard equivalents are listed in parentheses whenever applicable. The Battle Map and its menu bar look like this:

The Apple (⌘) menu

The Apple menu behaves exactly as it does within all other Macintosh applications and at the Finder. You have access to all desk accessories currently available to your System file. When running under MultiFinder with System 6.x.x, your Apple menu also contains a list of other applications currently running. Choosing any one of these applications will
bring it forward as the active application and send The Antietam Staff Ride to the background.

About Antietam... Choose this command to display the same startup window that is displayed when launching the application. To close this window, click anywhere on the window.

Help... Choose this command to access The Antietam Staff Ride on-line help system. This allows you to access information about menus and commands without leaving the application.

The File menu
As in most Macintosh applications, The Antietam Staff Ride File menu controls document-level activities, including the editing, setting preferences, and printing maps.

Editor Pallet... The Editor Pallet command brings up the SuperCard Runtime Editor floating pallet. This pallet contains the menus available in the SuperCard Runtime Editor. The Runtime Editor allows you to make changes to The Antietam Staff Ride while it is running and immediately see the consequences of your editing. (See page 81 of the SuperCard Addendum 1.5.)

Print Map... (S-P) The Print Map command prints the current map of the current window. If the map is larger than the paper size in your printer, the map will be printed a section at a time on as many sheets of paper as necessary. You can then fit together the pieces of paper as though they were tiles of a larger picture.
**Print Window...** The Print Window command prints every card of the active window.

**Print Selection...** The Print Selection command allows you to select a portion of a map or card for printing. After choosing this command, your cursor will change to a cross hair. Place the cross hair at the upper left-hand corner of the area to be printed, press down on the mouse button, and drag to the bottom right-hand corner. After you release the mouse button, the area selected will be sent to the printer.

**Preferences...** The Preferences command brings up the Preferences dialog box which allows you to control the manner information is presented. Audio battle cues such as cannon and rifle fire can be turned on or off by selecting either the *On* or *Off* Sound radio button. Units may be displayed then hidden or remain on the map as subsequent units are displayed by selecting either the *Builds* or *Don’t Build Unit* radio button. Divisional artillery may be displayed or remain hidden by selecting either the *Show* or *Don’t Show Artillery* radio button.

The Preferences dialog box looks like this:

```
Preferences

<table>
<thead>
<tr>
<th>Sound:</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units:</td>
<td>Build</td>
<td>Don’t Build</td>
</tr>
<tr>
<td>Artillery:</td>
<td>Show</td>
<td>Don’t Show</td>
</tr>
</tbody>
</table>

[Cancel] [OK]
```
Quit ($Q$) The Quit command exits the Antietam Staff Ride application, closing all open windows.

The Edit menu
Most of the commands in the Edit menu will be familiar to you if you have worked in other Macintosh applications.

*Undo* ($Z$) The Undo command steps backward to the previous operation performed. The Undo command will be dimmed if the last operation cannot be undone.

*Cut* ($H$) The Cut command deletes one or more selected objects and stores them on the Macintosh Clipboard, replacing the Clipboard’s previous contents. If no object is selected, the Cut command is dimmed.

*Copy* ($C$) The Copy command makes a copy of one or more selected objects and stores them in the Macintosh Clipboard, replacing the Clipboard’s previous contents. If no object is selected, the Copy command is dimmed.

*Paste* ($U$) The Paste command makes a copy of the items in the Macintosh Clipboard and places them on the current card in the current window. If the Clipboard is empty, the Paste command is dimmed.

*Clear* (delete, backspace, or clear) The Clear command deletes one or more selected objects, but does so without placing them in the Clipboard or disturbing the Clipboard’s contents. If no object is selected, the Clear command is dimmed.
Select All (⌘-A) The Select All command selects every object on the current card of the current window.

Show Clipboard The Show Clipboard command opens the Clipboard window and displays the contents of the Clipboard.

The Play menu

The Play menu allows you to select and view animated replays of the Battle of Antietam. The battle has been divided into eight parts: Hooker’s Attack, Hood’s Counterattack, Sedgwick’s Attack, French’s Attack, The Bloody Lane, Piper Farm, Christ’s Attack, Burnside’s Attack, and A.P. Hill’s Attack. This version covers Hooker’s attack and Hood’s counterattack. Follow-on versions will include the remaining battles and situations. A hierarchical menu will appear when you select one of the Play menu items. Each hierarchical menu contains a situation and several time period menu items.

Situation... This menu item brings up a battlefield map and a dialog box. Information on the situation and disposition of units prior to this particular engagement is presented through a sequence of overlays and narrative text. A narrative explanation of each overlay is presented in the dialog box each time the Next button is clicked. Click on the Back button to return to the previous overlay and narrative explanation.
5:45 to 6:00 Each of the eight engagements listed is further divided into 15 to 30 minute segments. If you select the Situation menu item first, you may transition through each of the time segments. You also have the option of selecting a particular time segment.

The Labels menu
The commands of the Labels menu toggle the display of Battle Map label overlays. These label overlays include the names of towns, roads, farms, bridges, churches, industry, woods, fords, and CSA and USA infantry and artillery units. A check mark appears before each overlay that is currently displayed. The Hide All command hides all currently displayed label overlays.

The Units menu
The commands of the Units menu toggle the display of CSA and USA infantry and artillery units. A check mark appears before each unit that is currently displayed. The Hide All command hides all currently displayed unit overlays.

The View menu
The commands of the View menu affect the display of battle casualty data, pictures of key leaders, order of battle data, notes, and the bibliography. A hierarchical menu pops up displaying the names of the key leaders when either the USA Leaders or CSA Leaders menu items are selected.

The Maps menu
The commands of Maps menu affect the display of the situation at Harper’s Ferry on September 15, 16, and 17: the situation at Sharpsburg at dawn on
September 17; and a map of the area around the Cornfield.

The Graphics menu

The commands of the Graphics menu affect the display of the map legend, photograph markers, and narrative balloons. The Map Legend menu item displays the graphics used on the maps to represent cover, roads, and fences. The map legend is shown in Appendix F. The Photo Markers menu item displays small white arrows on the current map. These arrows indicate the location and direction of view for a color photograph. To bring up the photograph, simply click on the arrow. The Narrative Balloons menu item displays small white balloons on the current map. These balloons indicate human interest stories that occurred at this location. To bring up the narrative, click on the balloon.
Battle Map

This section explains the use of the Battle Map menus and provides examples of the data available through use of these menus commands. Prior to viewing the animated battle, the user may access a situation brief for each of the phases listed in the Play menu. For example, to view the situation brief for Hooker's attack choose the Hooker's Attack command from the Play menu and a submenu is displayed at the right edge of the Hooker's Attack command. Continue holding the mouse button and drag the pointer to the submenu command Situation. Once the submenu command Situation is highlighted release the mouse button and the first situation narrative window will be displayed.

<table>
<thead>
<tr>
<th>Play</th>
<th>Situation...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hooker's Attack</td>
<td>Situation...</td>
</tr>
<tr>
<td>Hood's Counterattack</td>
<td>5:45 to 6:00 AM</td>
</tr>
<tr>
<td>Sedgwick's Attack</td>
<td>6:00 to 6:45 AM</td>
</tr>
<tr>
<td>French's Attack</td>
<td>6:45 to 7:00 AM</td>
</tr>
<tr>
<td>The Bloody Lane</td>
<td>7:00 to 7:15 AM</td>
</tr>
<tr>
<td>Piper Farm</td>
<td></td>
</tr>
<tr>
<td>Christ's Attack</td>
<td></td>
</tr>
<tr>
<td>Burnside's Attack</td>
<td></td>
</tr>
<tr>
<td>R.P. Hill's Attack</td>
<td></td>
</tr>
</tbody>
</table>

This window can be positioned anywhere on the screen by clicking on the shaded bar at the top of the window and dragging the window to a new position. To view the next narrative card, click the Next button. A new overlay or short animation is displayed with each new narrative card. To go back to the previous narrative and overlay, click on the Back button. The sequence of screen snapshots in Appendix C shows part of the situation brief for Hooker's Attack.
After the last situation narrative and overlay, you zoom to a small-scale battle map for the animated replay. When the small-scale battle map opens, the Battle Map is moved to the background of the screen and its menu is hidden. The first 10 map overlays in the animated sequence of Hooker's Attack is shown in Appendix D.

**Navigator Palette**

Control of the battle animation is done using the Navigator Palette. The Navigator Palette looks like this:

![Navigator Palette Diagram](image)

**Sound Button** If the sound waves are visible on the speaker, audio cues such as rifle and cannon fire will be played through the Macintosh stereo speakers. To turn the sound off, click once on the speaker and the sound waves will disappear. Click once again and the sound waves will reappear.

**Rewind Button** Click on the *Rewind* button to return to the first overlay in the animated sequence.

**Back Step Button** Click on the *Back Step* button to step back to the previous overlay.
Click on the Stop button to stop the animated sequence.

Click on the Step button to step through the animated sequence one frame at a time. When stepping through the animated battle sequence, a dialog box is presented for each overlay describing the events taking place.

Click on the Play button view the animated movement of units at approximately one frame a second.

The Grabbler is used to scroll the map. Click on the Grabbler and your cursor will change to a small open hand. Click on the map and drag in the direction you want the map to move.

Click on the Done button to return to the large-scale Battle Map.

Click on the Balloon Help button to turn on System 7 balloon help. Once balloon help is on, when you place the cursor over any of the buttons on the Navigator Palette, a small balloon will pop up with a description of the button.

Click on the Narrative Balloons button to display small narrative balloons on the map. When clicked on, these balloons bring up a narrative concerning an event which took place at this point on the battlefield.

The time displayed is the approximate battle time.
**Battle Leaders**

This user can view scanned photographs or paintings of the key leaders of the battle by using the **View** menu. For example, to display the photograph of Major General McCellan, choose the **USA Leaders** command from the **View** menu and a submenu is displayed. Continue holding the mouse button down and drag the pointer to the submenu command **MG George B. McCellan**. Once the submenu command **MG George B. McCellan** is highlighted, release the mouse button and the photograph will appear.
Order of Battle

You can access order of battle data two different ways. The first way is by clicking on a unit shown on the Battle Map. For example, when the unit labeled Hartsuff is clicked on, the unit data dialog box shown in figure 12 appears.

Figure 12. Unit Data Dialog Box

As the dialog box shows, Hartsuff is the commander of the 1st Brigade, 2nd Division, I Corps. If you click and hold the mouse down on the small balloon on the right side of the dialog box, the subordinate units of this brigade are displayed. When you let up on the mouse, the subordinate units are hidden. The subordinate unit data for Hartsuff’s Brigade is shown in figure 13.

Figure 13. Subordinate Unit Data Displayed
The second way to access order of battle data is to choose either the **CSA Order of Battle** or **USA Order of Battle** command from the **View** menu. For example, if you choose the **CSA Order of Battle** command the window shown in figure 14 is displayed. The diagram in the window shows the subordinate corps, reserve artillery, and cavalry of the Army of Northern Virginia. Click on any of the subordinate unit names to view their order of battle diagram. The order battle charts go down to battalion level for infantry units and battery level for artillery units. See Appendix E for order of battle examples.

Figure 14. CSA Order of Battle
### Battle Casualties

Casualties for the USA and CSA can be viewed by choosing either the **CSA Casualties** or **USA Casualties** commands from the **View** menu. The USA casualty Chart in figure 15 is displayed when **USA Casualties** is selected from the **View** menu.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Commander</th>
<th>Present</th>
<th>Engd</th>
<th>KIA</th>
<th>WIA</th>
<th>MIA</th>
<th>Total</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>I Corps</td>
<td>Hooker</td>
<td>14856</td>
<td>3425</td>
<td>140</td>
<td>638</td>
<td>34</td>
<td>812</td>
<td>23.7</td>
</tr>
<tr>
<td></td>
<td>Doubleday</td>
<td></td>
<td>3158</td>
<td>172</td>
<td>946</td>
<td>86</td>
<td>1204</td>
<td>38.1</td>
</tr>
<tr>
<td></td>
<td>Ricketts</td>
<td></td>
<td>2855</td>
<td>105</td>
<td>466</td>
<td>2</td>
<td>573</td>
<td>20.1</td>
</tr>
<tr>
<td></td>
<td>Meade</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>II Corps</td>
<td>Summer</td>
<td>18813</td>
<td>4829</td>
<td>210</td>
<td>942</td>
<td>16</td>
<td>1168</td>
<td>29.0</td>
</tr>
<tr>
<td></td>
<td>Richardson</td>
<td></td>
<td>5437</td>
<td>373</td>
<td>1593</td>
<td>244</td>
<td>2210</td>
<td>48.6</td>
</tr>
<tr>
<td></td>
<td>Sedgwick</td>
<td></td>
<td>5740</td>
<td>331</td>
<td>1498</td>
<td>151</td>
<td>1980</td>
<td>34.5</td>
</tr>
<tr>
<td></td>
<td>French</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>U Corps</td>
<td>Porter</td>
<td>12930</td>
<td>2274</td>
<td>17</td>
<td>90</td>
<td>2</td>
<td>189</td>
<td>4.8</td>
</tr>
<tr>
<td></td>
<td>Sykes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI Corps</td>
<td>Franklin</td>
<td>12300</td>
<td>(Unk)</td>
<td>6</td>
<td>58</td>
<td>2</td>
<td>66</td>
<td>(Unk)</td>
</tr>
<tr>
<td></td>
<td>Slocum</td>
<td></td>
<td>2585</td>
<td>66</td>
<td>277</td>
<td>31</td>
<td>374</td>
<td>14.5</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IX Corps</td>
<td>Cox</td>
<td>13819</td>
<td>3248</td>
<td>62</td>
<td>327</td>
<td>7</td>
<td>396</td>
<td>12.2</td>
</tr>
<tr>
<td></td>
<td>Willcox</td>
<td></td>
<td>3254</td>
<td>136</td>
<td>532</td>
<td>11</td>
<td>679</td>
<td>28.9</td>
</tr>
<tr>
<td></td>
<td>Sturgis</td>
<td></td>
<td>2914</td>
<td>225</td>
<td>821</td>
<td>148</td>
<td>1194</td>
<td>41.0</td>
</tr>
<tr>
<td></td>
<td>Rodman</td>
<td></td>
<td>3154</td>
<td>36</td>
<td>192</td>
<td>27</td>
<td>255</td>
<td>8.1</td>
</tr>
<tr>
<td></td>
<td>Scammon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>XII Corps</td>
<td>Mansfield</td>
<td>10126</td>
<td>4735</td>
<td>160</td>
<td>863</td>
<td>135</td>
<td>1158</td>
<td>24.5</td>
</tr>
<tr>
<td></td>
<td>Williams</td>
<td></td>
<td>2504</td>
<td>111</td>
<td>515</td>
<td>114</td>
<td>740</td>
<td>29.6</td>
</tr>
<tr>
<td></td>
<td>Greene</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cavalry</td>
<td></td>
<td>4320</td>
<td>4320</td>
<td>7</td>
<td>23</td>
<td>0</td>
<td>30</td>
<td>0.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>87164</td>
<td>53632</td>
<td>2157</td>
<td>9717</td>
<td>109</td>
<td>12882</td>
<td>24.0</td>
</tr>
</tbody>
</table>

Figure 15. Summary of USA Casualties

31
Appendix A. SuperCard Scripts for The Antietam Staff Ride

Antietam Staff Ride
PROJECT SCRIPT

Antietam Staff Ride
Version 1.0b16

THE MESSAGE HANDLERS USED IN THIS SCRIPT:
checkVersion, installMyMenus, loadMapName, openMapWindow, calculateWindowPart,
setPreferences, closeMyMenus, showNarrative,

THE FUNCTION HANDLERS USED IN THIS SCRIPT:
nine

HOME'S USED BY THIS SCRIPT:
nine

----- Startup Scripts: ---------------------------------------------

in openProject
  set cursor to watch
  hide menuBar
  checkVersion
  set the loc of wd "About Antietam" to the screenLoc
  play "Yankee Song"
  play "Yankee Song"
  setPreferences
  loadMapName
  installMyMenus
  hide msg
  visual dissolve slowly
  go next cd
  --openMapWindow
end openProject

on checkVersion
  set cursor to watch
  get version)
  put last word of it into verNum
  if verNum < 1.5 then
    set the loc of wd "Alerts" to the screenLoc
    open inv wd "Alerts"
    go cd "Alert 1"
    put "This project requires SuperCard version 1.5 or later."-
      into bg fid "Message" of cd "Alert 1" of this wd
    show this wd
    exit checkVersion
  end if
end checkVersion
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```
in loadMapName
  Global ProjectName  --The name of this project.
  Global MapName      --The name of the map window.
  Global SectionName  --The name of the map card.
  set cursor to watch
  put the short name of this project into ProjectName
  put the short name of wd 2 into MapName
  put the short name of wd 1 of wd 2 into SectionName
end loadMapName

in openMapWindow
  Global ProjectName
  Global MapName
  Global SectionName
  Global SoundIcon
  set cursor to watch
  set the loc of wd MapName of ProjectName to -1000,-1000
  show menuBar
  open wd MapName of ProjectName
  set the scroll of wd MapName of ProjectName to 323,134
  calculateWindowRect
  set the rect of wd MapName of ProjectName to the result
  close wd "About Antietam" of ProjectName
  set the loc of wd "Introduction" of ProjectName to the screenLoc
  open wd "Introduction" of ProjectName
end openMapWindow

in calculateWindowRect
  set cursor to watch
  get the screenRect
  add 3 to item 1 of it
  add 40 to item 2 of it
  subtract 3 from item 3 of it
  subtract 3 from item 4 of it
  put it into windowRect
  return windowRect
end calculateWindowRect

----- Install Menus/Load Data Scripts: --------------------------

on installMyMenus
  Global ProjectName
  Global RunTimeMens
  set cursor to watch
  put empty into RunTimeMens
  set lockMenus to true
  -- What menus are currently installed? Save their names into a variable.
  repeat with x = 1 to the number of current menus
    put the long name of currentMenu(x) into line x of RunTimeMens
  end repeat
  -- Now kill the menus.
```
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```plaintext
repeat with x = 1 to the number of lines in RunTimeMenus
    remove line x of RunTimeMenus
end repeat
-- Now open my own menus.
global numMenus:
global item:
get it - 1 into numMenus
repeat with x = 1 to numMenus
    insert menu x
end repeat
insert menu "Hooker's Attack" into item 1 of menu "Play"
insert menu "Hood's Counterattack" into item 2 of menu "Play"
insert menu "Sedgwick's Attack" into item 3 of menu "Play"
insert menu "French's Attack" into item 4 of menu "Play"
insert menu "USA Leaders" into item "USA Leaders" of menu "View"
insert menu "CSA Leaders" into item "CSA Leaders" of menu "View"
end installMenus

on setPreferences
    global projectName:
    global soundIsOn:
    global showArtillery:
    global buildUnits:
    if the hilite of cd btn "On" of cd "Preferences" of wd "Preferences" is true then
        put "Yes" into soundIsOn
        set the checkMark of item "Sound On" of menu "Control" of projectName to true
    else
        put "No" into soundIsOn
        set the checkMark of item "Sound On" of menu "Control" of projectName to false
    end if
    if the hilite of cd btn "Show" of cd "Preferences" of wd "Preferences" is true then
        put "Yes" into showArtillery
    else
        put "No" into showArtillery
    end if
    if the hilite of cd btn "Build" of cd "Preferences" of wd "Preferences" is true then
        put "Yes" into buildUnits
    else
        put "No" into buildUnits
    end if
end setPreferences

---- Shutdown Scripts: ------------------------------------------

on closeProject
    global projectName:
    global soundIsOn:
```

34
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```
set cursor to watch
closeMyMenus
set numberFormat to "0"
put the freesize of this project into theSize
if theSize > 200 then
    set the loc of wd "Notes" to the screenLoc
    put "Compacting the file" & return & projectName & "..." into
    bg id "Message" of cd "Note 1" if wd "Notes"
    open wd "Notes"
    compact
    close wd "Notes"
end if
if the helpBaloons is true then
    set the helpBaloons to false
end if
if soundIsOn is "Yes" then play "Taps"
wait i seconds
end closeProject

on closeMyMenus
    set cursor to watch
    set the lockMenus to true
    put empty into menuList
    put empty into menusToKill
    -- First, find out which menus are mine.
    repeat with x = 1 to the number of menus
        put return & the long name of menu x after menuList
    end repeat
    -- Now find out which of my menus are installed.
    repeat with x = 1 to the number of current menus
        if currentMenu(x) is in menuList then
            put return & currentMenu(x) after menusToKill
        end if
    end repeat
    -- Now remove my installed menus.
    repeat with x = 1 to the number of lines in menusToKill
        if line x of menusToKill is not empty then
            remove line x of menusToKill
        end if
    end repeat
    set the lockMenus to false
end closeMyMenus

on showNarrative
    Global projectName
    set cursor to watch
    put the short name of the target into cardName
    set the loc of wd "Narrative" of projectName to the screenLoc
    open cd cardName of wd "Narrative" of projectName
end showNarrative
```
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #1: Apple) ITEM #1: About Antietam...

on itemSelect
   Global ProjectName
   set the loc of window "About Antietam" to the screenLoc
   open window "About Antietam" of projectName
end itemSelect

(MENU #1: Apple) ITEM #2: Help...

on itemSelect
   answer "This option not available."
end itemSelect

(MENU #2: File) ITEM #1: Editor Pallet

on itemSelect
   editor pal
end itemSelect

(MENU #2: File) ITEM #2: Print Map...

on itemSelect
   answer "This option not available."
   -- Global MapName
   -- send "print card" to wd MapName
end itemSelect

(MENU #2: File) ITEM #3: Print Window...

on itemSelect
   answer "This option not available."
end itemSelect

36
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #2: File) ITEM #5: Print Selection...

in itemSelect
    answer "This option not available."
--trace
    -- global ShowClipboardOpen
    -- repeat until not exists!last cd grc of cd "Clipboard" of wd "Clipboard"
    -- delete last grc of cd "Clipboard" of wd "Clipboard"
    -- end repeat
    -- save all
    -- put SnApIct("Init") into a
    -- if the colorWorld then put 1500 into tune
    -- else put 200 into tune
    -- if not hasMemory(tune * 1024) then
    -- open in: wd "Alerts"
    -- set loc of this wd to screenLoc
    -- go cd "Alert 2"
    -- put "Requires 1500K of free memory to run adequately in color, and 200K--
    -- for black and white." into bg fld "Message" of cd "Alert 2" of wd "Alerts"
    -- show this wd
    -- exit itemSelect
    -- end if
    -- lock screen
    -- cut empty
    -- get hasMemory(8000 * 1024)
    -- put the number of grcs into saveNum
    -- put SnApIct("User")
    -- send "itemSelect" to item "Show Clipboard" of menu "Edit"
    -- setWindow wd "Clipboard"
    -- if the number of cd grcs <> saveNum then
    -- beep
    -- answer "Not enough memory to capture image."
    -- delete last cd grc of cd "Clipboard" of wd "Clipboard"
    -- end if
end itemSelect

(MENU #2: File) ITEM #7: Preferences...

in itemSelect
    Global ProjectName
    set the loc of wd "Preferences" of ProjectName to the screenLoc
    open wd "Preferences" of ProjectName
end itemSelect

(MENU #2: File) ITEM #9: Quit

in itemSelect
    -- Close all wds to quit.
    -- Close all wds
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

ANTIETAM STAFF RIDE MENU # 3: Edit

in itemSelect
  answer "This option not available."
end itemSelect

(MENU #3: Edit) ITEM #1: Undo

in itemSelect
  revert -- works in conjunction with the save commands in
  -- the other menu items
end itemSelect

(MENU #3: Edit) ITEM #2: ------------

in itemSelect

end itemSelect

(MENU #3: Edit) ITEM #3: Cut

in itemSelect
  put the selectedField into sField
  put the selectedChunk into sChunk
  save
  if sField is not empty
    then if sChunk is not empty then select sChunk
    cut
end itemSelect

(MENU #3: Edit) ITEM #4: Copy

in itemSelect
  copy
end itemSelect

(MENU #3: Edit) ITEM #5: Paste

in itemSelect
  -- put the selectedField into sField
  -- put the selectedChunk into sChunk
  -- save
  -- IF sField is NOT empty
  -- THEN IF sChunk is NOT empty THEN select sChunk
  --set tool of this wd to pointer
  paste
  --set tool of this wd to browse
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #3: Edit) ITEM #6: Clear

in itemSelect
  Global ProjectName
  put the selectedChunk into sChunk
  put the selectedField into sField
  save

  -- clear a text selection
  if sField is not empty then
    if sChunk is not empty then
      -- handle a flashing cursor in a word
      if word 4 of sChunk > word 2 of sChunk then
        select sChunk
        put empty into the selection
      else do "select after char" & word 4 of sChunk & "of" & sField -- WORKS AROUND BUG IN SC
    end if
    exit itemSelect
  end if
end if

  -- text was not selected so save contents of clipboard to scrap
  open window "clipboard scrap" of ProjectName
  put empty into contents
  -- clipboard contains text
  if clipboard() = "Text" then
    put "Text" into contents
    choose browse tool
    select text of fld "Text Scrap"
    paste text
  end if

  -- clipboard contains objects
  if clipboard() = "Objects" then
    put "Object" into contents
    choose pointer tool
    paste objects
  end if

  -- clipboard contains card
  if clipboard() = "CARD" then
    put "CARD" into contents
    paste card
  end if

  close window "clipboard scrap" of ProjectName
  cut -- cut selected objects

  -- restore contents of clipboard
  open window "clipboard scrap" of ProjectName
  if contents is "Text" then
Appendix A. SuperCard Scripts for The Antietam Staff Ride

choose browse tool
select text if field "Text Scrap" out
end if

if contents is "Object" then
choose pointer tool

-- selected is an undocumented object property
-- true = the object is selected
-- false = the object is not selected
repeat with i=1 to the number of btns
  set the selected of btn i to true -- selected is undocumented property
end repeat

repeat with i=1 to the number of cd flds
  set the selected of cd fld i to true
end repeat

repeat with i=1 to the number of cd graphics
  set the selected of cd graphic i to true
end repeat

cut objects
end if

if contents is "Card" then
  go to card 2
  cut card
end if

close window "clipboard scrap" of ProjectName
end itemSelect

(MENU #3: Edit) ITEM #7: Select All

on itemSelect
  if the selectedField is not empty
    then select text of the selectedField
end itemSelect

(MENU #3: Edit) ITEM #8: **********
on itemSelect

end itemSelect

(MENU #3: Edit) ITEM #9: Show Clipboard

on itemSelect
  answer "This option is not available."
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #4: Play):  -----------------
  in itemSelect
    Global ProjectName
    Global ProjectPlaying
    put "Hooker's Attack 1" into ProjectPlaying
    lock screen
    set the loc of wd "Cornfield" of project "Hooker's Attack 2" to the
    screenLoc
    open wd "Cornfield" of project "Hooker's Attack 2"
    set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
    open wd "Cornfield" of ProjectPlaying
    open wd "Navigator" of ProjectName
    set the checkbox of item "Palette" of menu "Control" of ProjectName to true
    unlock screen
  end itemSelect

(MENU #4: Play) ITEM #1: Hooker's Attack
  on itemSelect
    pass itemSelect
  end itemSelect

(MENU #4: Play) ITEM #1: Hood's Counterattack
  on itemSelect
    pass itemSelect
  end itemSelect

(MENU #4: Play) ITEM #1: Sedgwick's Attack
  on itemSelect
    pass itemSelect
  end itemSelect

(MENU #4: Play) ITEM #1: French's Attack
  on itemSelect
    pass itemSelect
  end itemSelect

(MENU #4: Play) ITEM #1: The Bloody Lane
  on itemSelect
    pass itemSelect
  end itemSelect

(MENU #4: Play) ITEM #1: Piper Farm
  in itemSelect
    pass itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

end itemSelect

(MENU #4: Play) ITEM #1: Christ's Attack
on itemSelect
  pass itemSelect
end itemSelect

(MENU #4: Play) ITEM #1: Burnside's Attack
on itemSelect
  pass itemSelect
end itemSelect

(MENU #4: Play) ITEM #1: A.P. Hill's Attack
on itemSelect
  pass itemSelect
end itemSelect

(MENU #5: Labels) ITEM #1: Hide All
on itemSelect
  Global ProjectName
  lock screen
  set cursor to busy
  get the number of items in menu "Labels" of ProjectName
  put it into numGraphics
  set cursor to busy
  repeat with n = 2 to numGraphics
    set cursor to busy
    if the checkMark of item n of menu "Labels" of ProjectName is true then
      send "itemSelect" to item n of menu "Labels" of ProjectName
      end if
  end repeat
  unlock screen
end itemSelect

(MENU #5: Labels) ITEM #2: 

end itemSelect

(MENU #5: Labels) ITEM #3: Towns
on itemSelect
  Global ProjectName
  Global MapName
  setWindow x@ MapName of ProjectName
set cursor to busy
lock screen
if the checkMark of the target is false then
  show grc "Sharpsburg"
  show grc "Mertersville"
  show grc "Porterstown"
  show grc "Smoketown"
  set the checkMark of the target to true
else
  hide grc "Sharpsburg"
  hide grc "Mertersville"
  hide grc "Porterstown"
  hide grc "Smoketown"
  set the checkMark of the target to false
end if
unlock screen
end itemSelect

on itemSelect
  Global ProjectName
  Global MapName
  set Window wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show grc "Hagerstown Pike"
    show grc "Smoketown Road"
    show grc "Boonsboro Pike"
    show grc "Shepherdstown Road"
    show grc "Lower Bridge Road"
    show grc "Sawmill Road"
    --show grc "Harpers Ferry Road"
    show grc "Landing Road"
    set the checkMark of the target to true
  else
    hide grc "Hagerstown Pike"
    hide grc "Smoketown Road"
    hide grc "Boonsboro Pike"
    hide grc "Shepherdstown Road"
    hide grc "Lower Bridge Road"
    hide grc "Sawmill Road"
    --hide grc "Harpers Ferry Road"
    hide grc "Landing Road"
    set the checkMark of the target to false
  end if
  unlock screen
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #5: Labels) ITEM #5: Farms

in itemSelect
  global ProjectName
  global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkmark of the target is false then
    show grc "Avey"
    show grc "Blackford"
    show grc "Clipp"
    show grc "Coffman"
    show grc "Cox"
    show grc "P. Domer"
    show grc "Ecker"
    show grc "Hauser"
    show grc "Heinz"
    show grc "Hoffman"
    show grc "Hotzel"
    show grc "Kennedy"
    show grc "Line"
    show grc "Magraw"
    show grc "C. Michael"
    show grc "Middlekauf"
    show grc "D.R. Miller"
    show grc "J.F. Miller"
    show grc "M. Miller"
    show grc "Morrison"
    show grc "Mumma"
    show grc "Neikirk"
    show grc "Newcomer"
    show grc "Newcomer"
    show grc "Nicodemus"
    show grc "D. Otto"
    show grc "J. Otto"
    show grc "H. Piper"
    show grc "S.D. Piper"
    show grc "A. Poffenberger"
    show grc "John Poffenberger"
    show grc "Jos. Poffenberger"
    show grc "S. Poffenberger"
    show grc "Pry"
    show grc "Reel"
    show grc "H. Rohrbach"
    show grc "N. Rohrbach"
    show grc "Poulette"
    show grc "Rowe"
    show grc "Schneibele"
    show grc "Sherrick"
    show grc "D. Smith"
    show grc "Snavely"
Appendix A. SuperCard Scripts for The Antietam Staff Ride

show grc "Thomas"
set the checkmark of the target to true
else
    hide grc "Avery"
    hide grc "Blackford"
    hide grc "Clipp"
    hide grc "Cliffman"
    hide grc "Cox"
    hide grc "R. Doner"
    hide grc "Ecker"
    hide grc "Hauser"
    hide grc "Heinz"
    hide grc "Hoffman"
    hide grc "Hotzel"
    hide grc "Kennedy"
    hide grc "Linde"
    hide grc "Magraw"
    hide grc "C. Michael"
    hide grc "Middlekauf"
    hide grc "D.R. Miller"
    hide grc "J.F. Miller"
    hide grc "M. Miller"
    hide grc "Morrisson"
    hide grc "Mumma"
    hide grc "Neikirk"
    hide grc "Newcomer"
    hide grc "Newcomer"
    hide grc "Nicodemus"
    hide grc "D. Otto"
    hide grc "J. Otto"
    hide grc "H. Piper"
    hide grc "S.D. Piper"
    hide grc "A. Poffenberger"
    hide grc "John Poffenberger"
    hide grc "Jos. Poffenberger"
    hide grc "S. Poffenberger"
    hide grc "Pry"
    hide grc "Reel"
    hide grc "H. Rohrbach"
    hide grc "N. Rohrbach"
    hide grc "Roulette"
    hide grc "Rowe"
    hide grc "Schneibele"
    hide grc "Sherrick"
    hide grc "D. Smith"
    hide grc "Snavely"
    hide grc "Thomas"
    set the checkmark of the target to false
end if
unlock screen
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #5: Labels) ITEM #6: Bridges

on itemSelect
Global ProjectName
Global MapName
setWindow wd MapName of ProjectName
set cursor to busy
lock screen
if the checkMark of the target is false then
    show grc "The Upper Bridge"
    show grc "The Middle Bridge"
    show grc "The Lower Bridge"
    set the checkMark of the target to true
else
    hide grc "The Upper Bridge"
    hide grc "The Middle Bridge"
    hide grc "The Lower Bridge"
    set the checkMark of the target to false
end if
unlock screen
end itemSelect

(MENU #5: Labels) ITEM #7: Churches

on itemSelect
Global ProjectName
Global MapName
setWindow wd MapName of ProjectName
set cursor to busy
lock screen
if the checkMark of the target is false then
    show grc "Dunkard Church"
    show grc "Lutheran Church"
    show grc "Ground Squirrel Church"
    set the checkMark of the target to true
else
    hide grc "Dunkard Church"
    hide grc "Lutheran Church"
    hide grc "Ground Squirrel Church"
    set the checkMark of the target to false
end if
unlock screen
end itemSelect

(MENU #5: Labels) ITEM #8: Industry

on itemSelect
Global ProjectName
Global MapName
setWindow wd MapName of ProjectName
set cursor to busy
lock screen
Appendix A. SuperCard Scripts for The Antietam Staff Ride

if the checkMark of the target is false then
  show grc "New Industry"
  show grc "Quarry"
  show grc "Stone Mill"
  show grc "S. Pry Mill"
  set the checkMark of the target to true
else
  hide grc "New Industry"
  hide grc "Quarry"
  hide grc "Stone Mill"
  hide grc "S. Pry Mill"
  set the checkMark of the target to false
end if
unlock screen
end itemSelect

(MENU #5: Labels) ITEM #9: Woods

on itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show grc "The North Woods"
    show grc "The East Woods"
    show grc "The West Woods"
    set the checkMark of the target to true
  else
    hide grc "The North Woods"
    hide grc "The East Woods"
    hide grc "The West Woods"
    set the checkMark of the target to false
  end if
  unlock screen
end itemSelect

(MENU #5: Labels) ITEM #10: Fords

on itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show grc "Snavely's Ford"
    show grc "Myer's Ford"
    set the checkMark of the target to true
  else
    hide grc "Snavely's Ford"
    hide grc "Myer's Ford"
  end if
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

hide grc "Snavely's Ford"
hide grc "Meyer's Ford"
set the checkMark of the target to false
end if
unlock screen
end itemSelect

(MENU #5: Labels) ITEM #11: -----------
on itemSelect
   pass itemSelect
end itemSelect

(MENU #5: Labels) ITEM #12: CSA Infantry Units
on itemSelect
   Global ProjectName
   Global MapName
   setWindow wd MapName of ProjectName
   set cursor to busy
   lock screen
   if the checkMark of the target is false then
      show grc "Jones Label"
      show grc "Grigsby Label"
      show grc "Lawton Label"
      show grc "31GA Label"
      show grc "Taliaferro Label"
      show grc "Starke Label"
      show grc "Law Label"
      show grc "Wofford Label"
      show grc "Hays Label"
      show grc "Early Label"
      show grc "Cav Label"
      set the checkMark of the target to true
   else
      hide grc "Jones Label"
      hide grc "Grigsby Label"
      hide grc "Lawton Label"
      hide grc "31GA Label"
      hide grc "Taliaferro Label"
      hide grc "Starke Label"
      hide grc "Law Label"
      hide grc "Wofford Label"
      hide grc "Hays Label"
      hide grc "Early Label"
      hide grc "Cav Label"
      set the checkMark of the target to false
   end if
Appendix A. SuperCard Scripts for The Antietam Staff Ride

if the checkMark of item "CSA Infantry" of menu "Units" of ProjectName is false then--
    send itemSelect to item "CSA Infantry" of menu "Units" of ProjectName
    unlock screen
end itemSelect

(MENU #5: Labels) ITEM #13: CSA Artillery Units

in itemSelect:
    Global ProjectName
    Global MapName
    setWindow wd MapName of ProjectName
    set cursor to busy
    lock screen
    if the checkMark of the target is false then
        show grc "Poague Label"
        show grc "S D Lee Label"
        show grc "Patterson Label"
        show grc "Johnson Label"
        show grc "Brockenbrough Label"
        show grc "Pelham Label"
        show grc "Carpenter Label"
        show grc "Wooding Label"
        show grc "Balthis Label"
        show grc "Raine Label"
        show grc "Ross Label"
        show grc "D'Aquin Label"
        set the checkMark of the target to true
    else
        hide grc "Poague Label"
        hide grc "S D Lee Label"
        hide grc "Patterson Label"
        hide grc "Johnson Label"
        hide grc "Brockenbrough Label"
        hide grc "Pelham Label"
        hide grc "Carpenter Label"
        hide grc "Wooding Label"
        hide grc "Balthis Label"
        hide grc "Raine Label"
        hide grc "Ross Label"
        hide grc "D'Aquin Label"
        set the checkMark of the target to false
    end if
    if the checkMark of item "CSA Artillery" of menu "Units" of ProjectName is false then--
        send itemSelect to item "CSA Artillery" of menu "Units" of ProjectName
        unlock screen
    end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #5: Labels) ITEM #14: -----------

on itemSelect
    pass itemSelect
end itemSelect

(MENU #5: Labels) ITEM #15: USA Infantry Units

on itemSelect
    Global ProjectName
    Global MapName
    setWindow wd MapName of ProjectName
    set cursor to busy
    lock screen
    if the checkMark of the target is false then
        show grc "Hofmann Label"
        show grc "Patrick Label"
        show grc "Gibbon Label"
        show grc "Phelps Label"
        show grc "Christian Label"
        show grc "3PA Cav Label"
        show grc "Anderson Label"
        show grc "Magilton Label"
        show grc "Hartsuff Label"
        show grc "Duryea Label"
        show grc "PA Res Label"
        show grc "2PA Label"
        show grc "13PA Label"
        show grc "5PA Label"
        show grc "Hooker Label"
        set the checkMark of the target to true
    else
        hide grc "Hofmann Label"
        hide grc "Patrick Label"
        hide grc "Gibbon Label"
        hide grc "Phelps Label"
        hide grc "Christian Label"
        hide grc "3PA Cav Label"
        hide grc "Anderson Label"
        hide grc "Magilton Label"
        hide grc "Hartsuff Label"
        hide grc "Duryea Label"
        hide grc "PA Res Label"
        hide grc "2PA Label"
        hide grc "13PA Label"
        hide grc "5PA Label"
        hide grc "Hooker Label"
        set the checkMark of the target to false
    end if
    if the checkMark of item "USA Infantry" of menu "Units" of ProjectName is false then
        send iter.Select to item "USA Infantry" of menu "Units" of ProjectName
    end if

50
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```plaintext
unlock screen
end itemSelect

(MENU #5: Labels) ITEM #16: USA Artillery Units

in itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show grc "Campbell Label"
    show grc "Edgell Label"
    show grc "Monroe Label"
    show grc "Reynolds Label"
    show grc "Ransom Label"
    show grc "Thompson Label"
    show grc "Cooper Label"
    show grc "Matthews Label"
    show grc "Simpson Label"
    set the checkMark of the target to true
  else
    hide grc "Campbell Label"
    hide grc "Edgell Label"
    hide grc "Monroe Label"
    hide grc "Reynolds Label"
    hide grc "Ransom Label"
    hide grc "Thompson Label"
    hide grc "Cooper Label"
    hide grc "Matthews Label"
    hide grc "Simpson Label"
    set the checkMark of the target to false
  end if
  if the checkMark of item "USA Artillery" of menu "Units" of ProjectName is false then
    send itemSelect to item "USA Artillery" of menu "Units" of ProjectName
  unlock screen
end itemSelect

(MENU #6: Units) ITEM #1: Hide All

on itemSelect
  Global ProjectName
  lock screen
  set cursor to busy
  get the number of items in menu "Units" of ProjectName
  put it into numGraphics
  set cursor to busy
  repeat with n = 2 to numGraphics
    set cursor to busy
```
Appendix A. SuperCard Scripts for The Antietam Staff Ride

if the checkMark of item n of menu "Units" of ProjectName is true then
    send "itemSelect" to item n of menu "Units" of ProjectName
end if
end repeat
if the checkMark of item "CSA Infantry" of menu "Units" is true then
    set the checkMark of item "CSA Infantry Units" of menu "Names" of ProjectName to false
end if
if the checkMark of item "CSA Artillery" of menu "Units" is true then
    set the checkMark of item "CSA Artillery Units" of menu "Names" of ProjectName to false
end if
if the checkMark of item "USA Infantry" of menu "Units" is true then
    set the checkMark of item "USA Infantry Units" of menu "Names" of ProjectName to false
end if
if the checkMark of item "USA Artillery" of menu "Units" is true then
    set the checkMark of item "USA Artillery Units" of menu "Names" of ProjectName to false
end if
unlock screen
end itemSelect

(MENU #6: Units) ITEM #2:  

on itemSelect
    pass itemSelect
end itemSelect

(MENU #6: Units) ITEM #3: CSA Infantry

on itemSelect
    Global ProjectName
    Global MapName
    setWindow wd MapName of ProjectName
    set cursor to busy
    lock screen
    if the checkMark of the target is false then
        show grc "Jones"
        show grc "Grigsby"
        show grc "Lawton"
        show grc "31GA"
        show grc "Trimble"
        show grc "Ripley"
        show grc "Law"
        show grc "Xofford"
        show grc "Taliaferro"
        show grc "Starke"
        show grc "Hays"
        show grc "Early"
        show grc "Cav 1"
    end if
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```
show grc "Cav 1"
show grc "Cav 2"
show grc "Cav 3"
show grc "Cav 4"
show grc "Cav 5"
show grc "Jones Label"
show grc "Grigsby Label"
show grc "Lawton Label"
show grc "31GA Label"
show grc "Trimble Label"
show grc "Ripley Label"
show grc "Law Label"
show grc "Wofford Label"
show grc "Taliaferro Label"
show grc "Starke Label"
show grc "Hays Label"
show grc "Early Label"
show grc "Cav Label"

set the checkMark of the target to true
if the checkMark of item "CSA Infantry Units" of menu "Labels" is false then
    set the checkMark of item "CSA Infantry Units" of menu "Labels" of ProjectName to true
end if
else
    hide grc "Jones"
    hide grc "Grigsby"
    hide grc "Lawton"
    hide grc "31GA"
    hide grc "Trimble"
    hide grc "Ripley"
    hide grc "Law"
    hide grc "Wofford"
    hide grc "Taliaferro"
    hide grc "Starke"
    hide grc "Hays"
    hide grc "Early"
    hide grc "Cav 1"
    hide grc "Cav 2"
    hide grc "Cav 3"
    hide grc "Cav 4"
    hide grc "Cav 5"
    hide grc "Jones Label"
    hide grc "Grigsby Label"
    hide grc "Lawton Label"
    hide grc "31GA Label"
    hide grc "Trimble Label"
    hide grc "Ripley Label"
    hide grc "Law Label"
    hide grc "Wofford Label"
    hide grc "Taliaferro Label"
    hide grc "Starke Label"
```

53
Appendix A. SuperCard Scripts for The Antietam Staff Ride

hide grc "Hays Label"
hide grc "Early Label"
hide grc "Cav Label"
set the checkMark of the target to false
if the checkMark of item "CSA Infantry Units" of menu "Labels" is true then
set the checkMark of item "CSA Infantry Units" of menu "Labels" of
ProjectName to false
end if
end if
unlock screen
end itemSelect

(MENU #6: Units) ITEM #4: CSA Artillery

on itemSelect
Global ProjectName
Global MapName
setWindow wd MapName of ProjectName
set cursor to busy
lock screen
if the checkMark of the target is false then
  show grc "Poague"
  show grc "Brockenbrough"
  show grc "Patterson"
  show grc "S D Lee"
  show grc "Johnson"
  show grc "Pelham"
  show grc "Carpenter"
  show grc "Wooding"
  show grc "Balthis"
  show grc "Raine"
  show grc "Ross"
  show grc "D'Aquin"
  show grc "Poague Label"
  show grc "Brockenbrough Label"
  show grc "Patterson Label"
  show grc "S D Lee Label"
  show grc "Johnson Label"
  show grc "Pelham Label"
  show grc "Carpenter Label"
  show grc "Wooding Label"
  show grc "Balthis Label"
  show grc "Raine Label"
  show grc "Ross Label"
  show grc "D'Aquin Label"
set the checkMark of the target to true
end if
if the checkMark of item "CSA Artillery Units" of menu "Labels" of
ProjectName is false then
set the checkMark of item "CSA Artillery Units" of menu "Labels" of
ProjectName to true
end if
else
  hide gtr "Pragma"
  hide gtr "Brookenbrough"
  hide gtr "Patterson"
  hide gtr "S D Lee"
  hide gtr "Johnson"
  hide gtr "Pelham"
  hide gtr "Carpenter"
  hide gtr "Wooding"
  hide gtr "Balthis"
  hide gtr "Raine"
  hide gtr "Ross"
  hide gtr "D'Aquin"
  hide gtr "Prague Label"
  hide gtr "Brookenbrough Label"
  hide gtr "Patterson Label"
  hide gtr "S D Lee Label"
  hide gtr "Johnson Label"
  hide gtr "Pelham Label"
  hide gtr "Carpenter Label"
  hide gtr "Wooding Label"
  hide gtr "Balthis Label"
  hide gtr "Raine Label"
  hide gtr "Ross Label"
  hide gtr "D'Aquin Label"
  set the checkMark of the target to false
  if the checkMark of item "CSA Artillery Units" of menu "Labels" of
  ProjectName is true then
    set the checkMark of item "CSA Artillery Units" of menu "Labels" of
    ProjectName to false
    end if
  end if
unlock screen
end itemSelect

(MENU #6: Units) ITEM #5: -----------

in itemSelect
  pass itemSelect
end itemSelect

(MENU #6: Units) ITEM #6: USA Infantry

in itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```plaintext
set the checkMark of the target to true
if the checkMark of item "USA Infantry Units" of menu "Labels" of ProjectName is false then
  set the checkMark of item "USA Infantry Units" of menu "Labels" of ProjectName to true
else
  hide gsc "Hofmann"
  hide gsc "Patrick"
  hide gsc "Gibbon"
  hide gsc "Phelps"
  hide gsc "Christian"
  hide gsc "3PA Cav"
  hide gsc "Anderson"
  hide gsc "Magilton"
  hide gsc "Hartsuff"
  hide gsc "Duryea"
  hide gsc "PA Res"
  hide gsc "1PA"
  hide gsc "13PA"
  hide gsc "SPA"
  hide gsc "SPA Label"
  hide gsc "Hofmann Label"
  hide gsc "Patrick Label"
  hide gsc "Gibbon Label"
  hide gsc "Phelps Label"
  hide gsc "Christian Label"
  hide gsc "3PA Cav Label"
  hide gsc "Anderson Label"
  hide gsc "Magilton Label"
  hide gsc "Hartsuff Label"
  hide gsc "Duryea Label"
  hide gsc "PA Res Label"
  hide gsc "2PA Label"
  hide gsc "13PA Label"
  hide gsc "SPA Label"
end if
```

56
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```plaintext
hide gtr "Dohm Label"
hide gtr "Pheips Label"
hide gtr "Christain Label"
hide gtr "FA Cav Label"
hide gtr "Anderson Label"
hide gtr "Magilton Label"
hide gtr "Harrsuff Label"
hide gtr "Duryea Label"
hide gtr "FA Res Label"
hide gtr "IPA Label"
hide gtr "IPA Label"
hide gtr "IPA Label"
set the checkMark of the target to false
if the checkMark of item "USA Infantry Units" of menu "Labels" of ProjectName is true then
set the checkMark of item "USA Infantry Units" of menu "Labels" of ProjectName to false
end if
end if
unlock screen
end itemSelect

(MENU #6: Units) ITEM #7: USA Artillery
```

```plaintext
on itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show gtc "Campbell"
    show gtc "Edgell"
    show gtc "Monroe"
    show gtc "Reynolds"
    show gtc "Ransom"
    show gtc "Thompson"
    show gtc "Cooper"
    show gtc "Matthews"
    show gtc "Simpson"
    show gtc "Campbell Label"
    show gtc "Edgell Label"
    show gtc "Monroe Label"
    show gtc "Reynolds Label"
    show gtc "Ransom Label"
    show gtc "Thompson Label"
    show gtc "Cooper Label"
    show gtc "Matthews Label"
    show gtc "Simpson Label"
    set the checkMark of the target to true
```
Appendix A. SuperCard Scripts for The Antietam Staff Ride

if the checkMark of item "USA Artillery Units" of menu "Labels" of ProjectName is false then
  set the checkMark of item "USA Artillery Units" of menu "Labels" of ProjectName to true
end if
else
  hide gr: "Campbell"
  hide gr: "Edgell"
  hide gr: "Monroe"
  hide gr: "Reynolds"
  hide gr: "Ransom"
  hide gr: "Thompson"
  hide gr: "Roper"
  hide gr: "Matthews"
  hide gr: "Simpson"
  hide gr: "Campbell Label"
  hide gr: "Edgell Label"
  hide gr: "Monroe Label"
  hide gr: "Reynolds Label"
  hide gr: "Ransom Label"
  hide gr: "Thompson Label"
  hide gr: "Roper Label"
  hide gr: "Matthews Label"
  hide gr: "Simpson Label"
set the checkMark of the target to false
if the checkMark of item "USA Artillery Units" of menu "Labels" of ProjectName is true then
  set the checkMark of item "USA Artillery Units" of menu "Labels" of ProjectName to false
end if
end if
unlock screen
end itemSelect

(MENU #7: View) ITEM #1: CSA Casualties
on itemSelect
  open wd "CSA Casualties" of project "Antietam Glossary"
end itemSelect

(MENU #7: View) ITEM #2: USA Casualties
on itemSelect
  open wd "USA Casualties" of project "Antietam Glossary"
end itemSelect

(MENU #7: View) ITEM #3: .............
on itemSelect
  pass itemSelect
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #7: View) ITEM #4: CSA Leaders
  in itemSelect
    pass itemSelect
  end itemSelect

(MENU #7: View) ITEM #5: USA Leaders
  in itemSelect
    pass itemSelect
  end itemSelect

(MENU #7: View) ITEM #6: ----------
  in itemSelect
    pass itemSelect
  end itemSelect

(MENU #7: View) ITEM #7: CSA Order of Battle
  in itemSelect
    open wd "CSA Order of Battle" of project "Antietam Glossary"
  end itemSelect

(MENU #7: View) ITEM #8: USA Order of Battle
  in itemSelect
    open wd "USA Order of Battle" of project "Antietam Glossary"
  end itemSelect

(MENU #8: Maps) ITEM #1: Harper's Ferry - Sep 15
  in itemSelect
    Global ProjectName
    open wd "Introduction" of ProjectName
  end itemSelect

(MENU #8: Maps) ITEM #2: Harper's Ferry - Sep 16
  in itemSelect
    Global ProjectName
    open wd "Harper's Ferry Sep 16" of ProjectName
  end itemSelect

(MENU #8: Maps) ITEM #3: Harper's Ferry - Sep 17
  in itemSelect
    Global ProjectName
    open wd "Harper's Ferry Sep 17" of ProjectName
  end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #8: Maps) ITEM #4: Sharpsburg - Sep 17

on itemSelect
  Global ProjectName
  open wd "Sharpsburg Sep 17" of ProjectName
end itemSelect

(MENU #8: Maps) ITEM #5: Cornfield

on itemSelect
  Global ProjectName
  open inv wd "Cornfield" of Project "Hooker's Attack 1"
  go to "Cornfield Map" of inv wd "Cornfield" of Project "Hooker's Attack 1"
  show wd "Cornfield" of Project "Hooker's Attack 1"
end itemSelect

(MENU #9: Graphics) ITEM #1: Map Legend

on itemSelect
  Global ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    set the loc of wd "Map Legend" of ProjectName to the screenLoc
    open wd "Map Legend" of ProjectName
    set the checkMark of the target to true
  else
    close wd "Map Legend" of ProjectName
    set the checkMark of the target to false
  end if
  unlock screen
end itemSelect

(MENU #9: Graphics) ITEM #2: Photo Markers

on itemSelect
  Global ProjectName
  Global MapName
  setWindow wd MapName of ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    show cd btn "Photo Marker 1"
    show cd btn "Industrial Revolution"
    set the checkMark of the target to true
  else
    hide cd btn "Photo Marker 1"
    hide cd btn "Industrial Revolution"
    set the checkMark of the target to false
  end if
  unlock screen
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #9: Graphics) ITEM #3: Narrative Balloons

on itemSelect
  Global ProjectName
  set cursor to busy
  lock screen
  if the checkMark of the target is false then
    send showNarrativeBalloon to this card
    show grt "In" of cd "Navigator" of wd "Navigator" of ProjectName
    set the checkMark of the target to true
  else
    send hideNarrativeBalloon to this card
    hide grt "On" of cd "Navigator" of wd "Navigator" of ProjectName
    set the checkMark of the target to false
  end if
  unlock screen
end itemSelect

(MENU #10: Control) ITEM #1: Palette

in itemSelect
  Global ProjectName
  Global MapName
  set cursor to watch
  setWindow wd MapName of ProjectName
  if the checkMark of the target is false then
    open wd "Navigator" of project ProjectName
    set the checkMark of the target to true
  else
    close wd "Navigator" of project ProjectName
    set the checkMark of the target to false
  end if
end itemSelect

(MENU #10: Control) ITEM #2: -----------------

in itemSelect
  pass itemSelect
end itemSelect

(MENU #10: Control) ITEM #3: Rewind

in itemSelect
  send "go to first card" to topwindow()
end itemSelect

(MENU #10: Control) ITEM #4: Back Step

in itemSelect
  send "go to prev card" to topwindow()
end itemSelect
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(MENU #10: Control) ITEM #5: Stop

in itemSelect
  pass itemSelect
end itemSelect

(MENU #10: Control) ITEM #6: Step

in itemSelect
  send "go to next card" to topwindow()
end itemSelect

(MENU #10: Control) ITEM #7: Play

in itemSelect
  pass itemSelect
end itemSelect

(MENU #10: Control) ITEM #8: --

in itemSelect
  pass itemSelect
end itemSelect

(MENU #10: Control) ITEM #9: Sound On

in itemSelect
  global SoundIsOn
  set cursor to watch
  if the checkMark of the target is false then
    put "Yes" into SoundIsOn
    set the checkMark of the target to true
  else
    put "No" into SoundIsOn
    set the checkMark of the target to false
  end if
end itemSelect

(MENU #11: Hooker's Attack) ITEM #1: Situation...

in itemSelect
  open wd "Situation" of project "Hooker's Attack 1"
end itemSelect

(MENU #11: Hooker's Attack) ITEM #2: 5:45 to 6:00 AM

in itemSelect
  global ProjectName
  global ProjectPlaying
  put "Hooker's Attack 1" into ProjectPlaying
  lock screen

62
Appendix A. SuperCard Scripts for The Antietam
Staff Ride

set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
open wd "Cornfield" of ProjectPlaying
open wd "Navigator" of ProjectName
set the checkMark of item "Palette" of menu "Control" of ProjectName to true
unlock screen
end itemSelect

(MENU #11: Hooker's Attack) ITEM #3: 6:00 to 6:45 AM

in itemSelect
  Global ProjectName
  Global ProjectPlaying
  set cursor to watch
  put "Hooker's Attack 2" into ProjectPlaying
  lock screen
  set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
  open wd "Cornfield" of ProjectPlaying
  open wd "Navigator" of ProjectName
  set cursor to watch
  set the checkMark of item "Palette" of menu "Control" of ProjectName to true
  unlock screen
end itemSelect

(MENU #11: Hooker's Attack) ITEM #4: 6:45 to 7:00 AM

in itemSelect
  pass itemSelect
end itemSelect

(MENU #11: Hooker's Attack) ITEM #5: 7:00 to 7:15 AM

in itemSelect
  pass itemSelect
end itemSelect

(MENU #12: Hood's Counterattack) ITEM #1: Situation...

in itemSelect
  --open wd "Situation" of project "Hood's Counterattack"
end itemSelect

(MENU #12: Hood's Counterattack) ITEM #2: 7:15 to 7:45 AM

--on itemSelect
  -- Global ProjectName
  -- Global ProjectPlaying
  -- put "Hood's Counterattack" into ProjectPlaying
  -- lock screen
  -- set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
  -- open wd "Cornfield" of ProjectPlaying
Appendix A. SuperCard Scripts for The Antietam Staff Ride

-- open wd "Navigator" of ProjectName
-- set the checkMark of item "Palette" of menu "Control" of ProjectName to true
-- unlock screen
--end itemSelect

(MENU #12: Hood's Counterattack) ITEM #3: 7:45 to 8:15 AM
--on itemSelect
-- Global ProjectName
-- Global ProjectPlaying
-- set cursor to watch
-- put "Hood's Counterattack" into ProjectPlaying
-- lock screen
-- set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
-- open wd "Cornfield" of ProjectPlaying
-- open wd "Navigator" of ProjectName
-- set cursor to watch
-- set the checkMark of item "Palette" of menu "Control" of ProjectName to true
-- unlock screen
--end itemSelect

(MENU #12: Hood's Counterattack) ITEM #4: 8:15 to 8:30 AM
on itemSelect
  pass itemSelect
end itemSelect

(MENU #12: Hood's Counterattack) ITEM #5: 8:30 to 9:00 AM
on itemSelect
  pass itemSelect
end itemSelect

(WD #1, BG #1, CD #1)
on showNarrativeBalloons
  set cursor to watch
  lock screen
  show grc "Samual Mumma"
  unlock screen
end showNarrativeBalloons

on hideNarrativeBalloons
  set cursor to watch
  lock screen
  hide grc "Samual Mumma"
  unlock screen
end hideNarrativeBalloons
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #1, BG #1, CD #1) BUTTON #1: Introduction

on mouseUp
  Global ProjectName
  Global MapName
  lock screen
  set the loc of wd "Introduction" of ProjectName to the screenLoc
  open wd "Introduction" of ProjectName
  hide wd "About Antietam" of ProjectName
  unlock screen
end mouseUp

(WD #1, BG #1, CD #1) BUTTON #2: Instructions

on mouseUp
  answer "Not available in this version."
end mouseUp

(WD #1, BG #1, CD #1) BUTTON #3: Battle Map

on mouseUp
  Global ProjectName
  Global MapName
  set cursor to watch
  lock screen
  --set the loc of wd MapName of ProjectName to -1000,-1000
  show menuBar
  open wd MapName of ProjectName
  set the scroll of wd MapName of ProjectName to 328,134
  calculateWindowRect
  set the rect of wd MapName of ProjectName to the result
  show wd MapName of ProjectName
  close wd "About Antietam"
  unlock screen
end mouseUp

(WD #2, BG #1) BUTTON #1: Hooker

on mouseUp
  end mouseUp

(WD #2, BG #1, CD #1) BUTTON #1: Photo Marker 1

on mouseUp
  open wd "Photos" of project "Color Photos"
end mouseUp
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #2, BG #1, CD #1) BUTTON #2: Industrial Revolution
on mouseUp
    launch "Industrial Revolution" with "Simple Player"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #25: Hartsuff
on mouseUp
    open cd "Hartsuff" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #26: Duryea
on mouseUp
    open cd "Duryea" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #85: Anderson
on mouseUp
    open cd "Anderson" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #86: Magilton
on mouseUp
    open cd "Magilton" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #89: 2PA
on mouseUp
    open cd "2PA" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #90: 13PA
on mouseUp
    open cd "13PA" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #91: 5PA
on mouseUp
    open cd "5PA" of wd "USA Units"
end mouseUp
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #2, BG #1, CD #1) GRAPHIC #101: Anderson Label
on mouseUp
  open cd "Anderson" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #104: 2PA Label
on mouseUp
  open cd "2PA" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #118: 13PA Label
on mouseUp
  open cd "13PA" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #119: 5PA Label
on mouseUp
  open cd "5PA" of wd "USA Units"
end mouseUp

(WD #2, BG #1, CD #1) GRAPHIC #199: Samuel Mumma
on mouseUp
  showNarrative
end mouseUp

(WD #3, BG #1) BUTTON #1: Done
on mouseUp
  close this wd
  open wd "Harper's Ferry" of project "Antietam Campaign Maps"
end mouseUp

(WD #3, BG #1) BUTTON #2: Back
on mouseUp
  visual dissolve
  go prev cd
end mouseUp

(WD #3, BG #1, CD #1) BUTTON #1: Back
on mouseUp
  Global ProjectName
  lock screen
  close this wd
  show wd "About Antietam" of ProjectName
Appendix A. SuperCard Scripts for The Antietam Staff Ride

unlock screen
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #1: On
on mouseUp
  Global ProjectName
  setSound 104, 105, short id of me
  hide grc "Sound Off" of cd "Navigator" of wd "Navigator" of ProjectName
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #2: Off
on mouseUp
  Global ProjectName
  setSound 104, 105, short id of me
  show grc "Sound Off" of cd "Navigator" of wd "Navigator" of ProjectName
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #3: Build
on mouseUp
  setPreference 107, 108, short id of me
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #4: Don't Build
on mouseUp
  setPreference 107, 108, short id of me
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #5: OK
on mouseUp
  Global SoundIsOn
  Global ShowArtillery
  if the hilite of cd btn "On" is true then
    put "Yes" into SoundIsOn
  else
    put "No" into SoundIsOn
  end if
  if the hilite of cd btn "Show" is true then
    put "Yes" into ShowArtillery
  else
    put "No" into ShowArtillery
  end if
  close this wd
end mouseUp
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #4, BG #1, CD #1) BUTTON #6: Cancel

on mouseUp
  close this wd
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #7: Show

on mouseUp
  setArtillery 107, 103, short id of me
end mouseUp

(WD #4, BG #1, CD #1) BUTTON #8: Don't Show

on mouseUp
  setArtillery 107, 103, short id of me
end mouseUp

(WD #5, BG #1) BUTTON #1: OK

on mouseUp
  close this wd
end mouseUp

(WD #7, BG #1, CD #1) FIELD #10: Battle Time

on mouseEnter
  show help balloon at rect of me with cd fld "Battle Time Help"
end mouseEnter

(WD #7, BG #1, CD #1) BUTTON #1: Grabbler

on mouseUp
  -- This first loop does nothing but hold the script until the
  -- mouse is down.
  repeat until the mouse is down
    put 5 into a
  end repeat
  -- This sends the grabber message to the toptwindow()
  repeat until the mouse is up
    send "grabber" to topwindow()
  end repeat
end mouseUp

on mouseEnter
  show help balloon at rect of me with cd fld "Grabbler"
end mouseEnter
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #7, BG #1, CD #1) BUTTON #2: Rewind
	on mouseEnter
	show help balloon at rect of me with cd fld "Rewind"
end mouseEnter
	on mouseUp
	send "go to first card" to topwindow()
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #3: Back Step
	on mouseEnter
	show help balloon at rect of me with cd fld "Back Step"
end mouseEnter
	on mouseUp
	send "go to prev card" to topwindow()
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #4: Stop
	on mouseEnter
	show help balloon at rect of me with cd fld "Stop"
end mouseEnter
	on mouseUp
	answer "Not available in this version."
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #5: Step
	on mouseEnter
	show help balloon at rect of me with cd fld "Step"
end mouseEnter
	on mouseUp
	Global ViewMethod
	put "Step" into ViewMethod
	send "go to next card" to topwindow()
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #6: Play
	on mouseEnter
	show help balloon at rect of me with cd fld "Play"
end mouseEnter
	on mouseUp
	Global ProjectName
	Global ProjectPlaying
Appendix A. SuperCard Scripts for The Antietam Staff Ride

Global ViewMethod
put "Continuous" into ViewMethod
set cursor to watch
set the hilite of me to true
setWindow wd "Cornfield" of ProjectPlaying
if ProjectPlaying is "Hooker's Attack 1" then
  go cd "Cornfield 05:45:20"
  go rd "Cornfield 05:45:40"
  go cd "Cornfield 05:46:00"
  go cd "Cornfield 05:46:20"
  go cd "Cornfield 05:46:40"
  go cd "Cornfield 05:46:40.5"
  go cd "Cornfield 05:47:00"
  go cd "Cornfield 05:47:20"
  go cd "Cornfield 05:47:40"
  go cd "Cornfield 05:48:00"
  go cd "Cornfield 05:48:20"
  go cd "Cornfield 05:48:40"
  go cd "Cornfield 05:49:00"
  go cd "Cornfield 05:49:20"
  go cd "Cornfield 05:49:40"
  go cd "Cornfield 05:50:00"
  go cd "Cornfield 05:50:20"
  go cd "Cornfield 05:50:40"
  go cd "Cornfield 05:51:00"
  go cd "Cornfield 05:51:20"
  go cd "Cornfield 05:51:40"
  go cd "Cornfield 05:52:00"
  go cd "Cornfield 05:52:20"
  go cd "Cornfield 05:52:40"
  go cd "Cornfield 05:53:00"
  go cd "Cornfield 05:53:20"
  go cd "Cornfield 05:53:40"
  go cd "Cornfield 05:54:00"
  go cd "Cornfield 05:54:20"
  go cd "Cornfield 05:54:40"
  go cd "Cornfield 05:55:00"
  go cd "Cornfield 05:55:20"
  go cd "Cornfield 05:55:40"
  go cd "Cornfield 05:56:00"
  go cd "Cornfield 05:56:20"
  go cd "Cornfield 05:56:40"
  go cd "Cornfield 05:57:00"
  go cd "Cornfield 05:57:20"
  go cd "Cornfield 05:57:40"
  go cd "Cornfield 05:58:00"
  go cd "Cornfield 05:58:20"
  go cd "Cornfield 05:58:40"
  go cd "Cornfield 05:59:00"
  go cd "Cornfield 05:59:20"
  go cd "Cornfield 05:59:40"
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```prolog
end if
if ProjectPlaying is "Hooker's Attack 2" then
  go cd "Cornfield 06:00:00"
  go cd "Cornfield 06:01:00"
  go cd "Cornfield 06:02:00"
  go cd "Cornfield 06:03:00"
  go cd "Cornfield 06:04:00"
  go cd "Cornfield 06:05:00"
  go cd "Cornfield 06:06:00"
  go cd "Cornfield 06:07:00"
  go cd "Cornfield 06:08:00"
  go cd "Cornfield 06:09:00"
  go cd "Cornfield 06:10:00"
  go cd "Cornfield 06:11:00"
  go cd "Cornfield 06:12:00"
  go cd "Cornfield 06:13:00"
  go cd "Cornfield 06:14:00"
  go cd "Cornfield 06:15:00"
  go cd "Cornfield 06:16:00"
  go cd "Cornfield 06:17:00"
  go cd "Cornfield 06:18:00"
  go cd "Cornfield 06:19:00"
  go cd "Cornfield 06:20:00"
  go cd "Cornfield 06:21:00"
  go cd "Cornfield 06:22:00"
  go cd "Cornfield 06:23:00"
  go cd "Cornfield 06:24:00"
  go cd "Cornfield 06:25:00"
  go cd "Cornfield 06:26:00"
  go cd "Cornfield 06:27:00"
  go cd "Cornfield 06:28:00"
  go cd "Cornfield 06:29:00"
  go cd "Cornfield 06:30:00"
  go cd "Cornfield 06:31:00"
  go cd "Cornfield 06:32:00"
  go cd "Cornfield 06:33:00"
  go cd "Cornfield 06:34:00"
  go cd "Cornfield 06:35:00"
  go cd "Cornfield 06:36:00"
  go cd "Cornfield 06:37:00"
  go cd "Cornfield 06:38:00"
  go cd "Cornfield 06:39:00"
  go cd "Cornfield 06:40:00"
  go cd "Cornfield 06:41:00"
  go cd "Cornfield 06:42:00"
  go cd "Cornfield 06:43:00"
  go cd "Cornfield 06:44:00"
  go cd "Cornfield 06:45:00"
end if
set the h:light of me to false
end mouseup
```
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #7, BG #1, CD #1) BUTTON #7: Done

in mouseEnter
  show help balloon at rect of me with cd fd "Done"
end mouseEnter

in mouseUp
  Global ProjectPlaying
  close this wd
  close wd "Cornfield" of project "Hooker's Attack 1"
  close wd "Step Narrative" of ProjectPlaying
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #8: Sound

in mouseEnter
  show help balloon at rect of me with cd fd "Sound"
end mouseEnter

on mouseUp
  Global ProjectName
  Global SoundIsOn
  if SoundIsOn is "Yes" then
    put "No" into SoundIsOn
    set the hilite of cd btn "On" of cd "Preferences" of wd "Preferences" of ProjectName to false
    set the hilite of cd btn "Off" of cd "Preferences" of wd "Preferences" of ProjectName to true
    show fr "Sound Off"
  else
    put "Yes" into SoundIsOn
    set the hilite of cd btn "On" of cd "Preferences" of wd "Preferences" of ProjectName to true
    set the hilite of cd btn "Off" of cd "Preferences" of wd "Preferences" of ProjectName to false
    hide fr "Sound Off"
  end if
end mouseUp

(WD #7, BG #1, CD #1) BUTTON #9: Balloon Help

in mouseEnter
  show help balloon at rect of me with cd fd "Balloon Help"
end mouseEnter

in mouseUp
  if the helpBalons is false then
    set the helpBalons to true
  else
    set the helpBalons to false
  end if
end mouseUp

73
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #7, BG #1, CD #1) BUTTON #10: Narrative Balloons

in mouseEnter
    show help balloon at rect of me with cd fld "Narrative Balloons"
end mouseEnter

in mouseUp
    Global ProjectName
    Global ProjectPlaying
    Global CurrentCard
    if the checkMark of item "Narrative Balloons" of menu "Graphics" of ProjectName is false then
        set the checkMark of item "Narrative Balloons" of menu "Graphics" of ProjectName to true
        send showNarrativeBalloons to cd CurrentCard of wd "Cornfield" of ProjectPlaying
        show grc "On"
    else
        set the checkMark of item "Narrative Balloons" of menu "Graphics" of ProjectName to false
        send hideNarrativeBalloons to cd CurrentCard of wd "Cornfield" of ProjectPlaying
        hide grc "On"
    end if
end mouseUp

(WD #7, BG #1, CD #1) GRAPHIC #11: Battle Time

in mouseEnter
    show help balloon at rect of me with cd fld "Battle Time Help"
end mouseEnter

(WD #8, BG #1, CD #1) BUTTON #1: Done

on mouseUp
    send itemSelect to item "Map Legend" of menu "Graphics"
end mouseUp

(WD #10, BG #1, CD #1) GRAPHIC #2: ID 111

on mouseDown
    show cd fld "Campbell Info"
end mouseDown

on mouseUp
    hide cd fld "Campbell Info"
end mouseUp
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #10, BG #2, CD #2) GRAPHIC #1: ID 112

in mouseDown
  show ri id "Duryea Info"
end mouseDown

in mouseUp
  hide ri id "Duryea Info"
end mouseUp

(WD #10, BG #2, CD #3) GRAPHIC #1: 3d Bde Info

in mouseDown
  show ri id "3d Bde Info"
end mouseDown

in mouseUp
  hide ri id "3d Bde Info"
end mouseUp

(WD #10, BG #2, CD #3) GRAPHIC #2: Hartsuff Info

in mouseDown
  show ri id "Hartsuff Info"
end mouseDown

in mouseUp
  hide ri id "Hartsuff Info"
end mouseUp

(WD #10, BG #2, CD #4) GRAPHIC #1: 3d Bde Info

in mouseDown
  show ri id "3d Bde Info"
end mouseDown

in mouseUp
  hide ri id "3d Bde Info"
end mouseUp

(WD #10, BG #2, CD #4) GRAPHIC #2: Anderson Info

in mouseDown
  show ri id "Anderson Info"
end mouseDown

in mouseUp
  hide ri id "Anderson Info"
end mouseUp

75
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #10, BG #2, CD #5) GRAPHIC #1: 3PA Cav

in mouseDown
  show cd fld "3PA Cav Info"
end mouseDown

in mouseUp
  hide cd fld "3PA Cav Info"
end mouseUp

(WD #11, BG #1) BUTTON #1: Done

in mouseUp
  close this wd
end mouseUp

Hooker's Attack 1
PROJECT SCRIPT
-- Version 1.0b16

in startup
  lock screen
  set the loc of wd 1 of this project to -1000,-1000
  unlock screen
  go project "Antietam Staff Ride"
end startup

in closeProject
  Global ProjectName
  set cursor to watch
  set numberformat to "0"
  put the freesize of this project into theSize
  if theSize > 200 then
    set the loc of wd "Notes" of ProjectName to the screenLoc
    put "Compacting the file&return&ProjectName&"..." into-
    bg fld "Message" of cd "Note 1" of wd "Notes" of ProjectName
    open wd "Notes" of ProjectName
    Compact
    close wd "Notes" of ProjectName
  end if
end closeProject

in showNarrative
  Global ProjectPlaying
  set cursor to watch
  put the short name of the target into cdrName
  set the loc of wd "Narrative" of ProjectPlaying to the screenLoc
  open cd cdrName of wd "Narrative" of ProjectPlaying
end showNarrative
Appendix A. SuperCard Scripts for The Antietam Staff Ride

WINDOW #1: Cornfield

in openWindow
    Global ProjectName
    hide menuBar
    if ProjectName is "Antietam Staff Ride" then
        insert menu "Control" of ProjectName
        end if
end openWindow

in closeWindow
    Global ProjectName
    show menuBar
    if ProjectName is "Antietam Staff Ride" then
        remove menu "Control" of ProjectName
        end if
end closeWindow

(WD #1) BACKGROUND #1: Cornfield

on showNarrativeBalloons
    answer "There are no narrative balloons on this map."
end showNarrativeBalloons

on hideNarrativeBalloons
    answer "There are no narrative balloons on this map."
end hideNarrativeBalloons

(WD #1, BG #1, CD #1) FIELD #1: Major Von Borcke

in mouseDown
    hide me
end mouseDown

(WD #1, BG #1, CD #1) GRAPHIC #39: Sergeant Moore

in mouseUp
    showNarrative
end mouseUp

(WD #1, BG #1, CD #1) GRAPHIC #40: Major Von Borcke

in mouseUp
    showNarrative
end mouseUp

(WD #1, BG #1, CD #1) GRAPHIC #41: Private Worsham

in mouseUp
    showNarrative
end mouseUp
Appendix A. SuperCard Scripts for The Antietam
Staff Ride

(WD #1, BG #1, CD #1) GRAPHIC #42: Major General Hooker
in mouseUp
  showNarrative
end mouseUp

(WD #2, BG #1) BUTTON #1: Back
in mouseUp
  global ShowArtillery
  if ShowArtillery is "No" then
    get the num of this cd
    put it - 1 into prevCard
    if prevCard is 0 then
      close this wd
      exit mouseUp
    end if
    get the short name of card prevCard
    put last word of it into cardType
    put first word of it into commanderName
    put prevCard - 1 into cardBeforePrev
    if commanderName is "Jones" then
      put prevCard - 4 into cardBeforePrev
    end if
    if commanderName is "Hood's" then
      put prevCard - 2 into cardBeforePrev
    end if
    if commanderName is "Stuart's" then
      close this wd
      exit mouseUp
    end if
    if cardType is "Artillery" then
      visual scroll right fast
      go cd cardBeforePrev
    else
      visual scroll right fast
      go prev cd
    end if
  else
    visual scroll right fast
    go prev cd
  end if
end mouseUp

(WD #2, BG #1) BUTTON #2: Next
in mouseUp
  global ShowArtillery
  if ShowArtillery is "No" then
    get the num of this cd
    put it + 1 into nextCard
    get the short name of card nextCard
Appendix A. SuperCard Scripts for The Antietam Staff Ride

```
put last word of it into cardType
put first word of it into commanderName
put nextCard - 1 into cardAfterNext
if commanderName is "Jones" then
  put nextCard + 4 into cardAfterNext
end if
if commanderName is "Hood's" then
  put nextCard - 1 into cardAfterNext
end if
if commanderName is "Stuart's" then
  go last cd
  exit mouseUp
end if
if cardType is "Artillery" then
  visual scroll left fast
  go cd cardAfterNext
else
  visual scroll left fast
  go next cd
end if
else
  visual scroll left fast
  go next cd
end if
end mouseUp

(WD #2, BG #1, CD #38) BUTTON #1: ID 108

on mouseUp
  Global ProjectName
  Global ProjectPlaying
  close this wd
  put "Hooker's Attack 1" into ProjectPlaying
  lock screen
  set the loc of wd "Cornfield" of ProjectPlaying to the screenLoc
  open wd "Cornfield" of ProjectPlaying
  open wd "Navigator" of ProjectName
  set the checkMark of item "Palette" of menu "Control" of ProjectName to true
  unlock screen
end mouseUp

(WD #3, BG #1, CD #3) BUTTON #1: Common Time

on mouseUp
  lock screen
  put the short name of me into cardName
  set the loc of wd "Glossary" of project "Antietam Glossary" to the screenLoc
  open cd cardName of wd "Glossary" of project "Antietam Glossary"
  unlock screen
end mouseUp

79
Appendix A. SuperCard Scripts for The Antietam Staff Ride

(WD #3, BG #1, CD #3) BUTTON #2: Columns of Divisions
on mouseUp
  lock screen
  put the short name of me into cardName
  set the loc of wd "Glossary" of project "Antietam Glossary" to the screenLoc
  open cd cardName of wd "Glossary" of project "Antietam Glossary"
  unlock screen
end mouseUp

(WD #3, BG #1, CD #4) BUTTON #1: Limber
on mouseUp
  lock screen
  put the short name of me into cardName
  set the loc of wd "Glossary" of project "Antietam Glossary" to the screenLoc
  open cd cardName of wd "Glossary" of project "Antietam Glossary"
  unlock screen
end mouseUp

(WD #3, BG #1, CD #9) BUTTON #1: Skirmishers
on mouseUp
  lock screen
  put the short name of me into cardName
  set the loc of wd "Glossary" of project "Antietam Glossary" to the screenLoc
  open cd cardName of wd "Glossary" of project "Antietam Glossary"
  unlock screen
end mouseUp

(WD #4, BG #1) BUTTON #1: Done
on mouseUp
  close this wd
end mouseUp
Appendix B. Introduction Maps
Harper's Ferry – Sep 16
Appendix B. Introduction Maps
Sharpsburg – Dawn Sep 17
On the morning of the 17th, Hooker’s stated objective to his commanders was the high ground one mile south of their current positions just East of Dunker Church. His plan was to attack due south toward Dunkard Church along the axis of Hagerstown Pike.
Appendix C. Situation Brief for Hooker’s Attack:

The First Division (Doubleday) was to advance on the right—through the Miller farm towards the West Woods. The Second Division (Ricketts) was to advance on the left—through the cornfield and East Woods.
Appendix C. Situation Brief for Hooker's Attack: Screen Shot 3

The Third Division (Meade) was to back up the other two divisions from his position in the center. (Hooker kept a large reserve because of his concern about his right flank.)
Appendix C. Situation Brief for Hooker’s Attack:
Screen Shot 4

Hooker’s First Corps consisted of 3 Divisions:
First Division: Brig. Gen. Abner Doubleday
Second Division: Brig. Gen. James Ricketts
Third Division: Brig. Gen George G. Meade
Appendix C. Situation Brief for Hooker's Attack: Screen Shot 5

Doubleday's Division consisted of 4 brigades:
First Brigade: Colonel W. Phelps
Second Brigade: Colonel J. Wm. Hofmann
Third Brigade: Colonel Marsena Patrick
Fourth Brigade: Colonel John Gibbon
Appendix C. Situation Brief for Hooker's Attack: Screen Shot 6

Doubleday’s Artillery consisted of 4 batteries (24 guns):
1st NH Indep. Light: Lieut. F.M. Edgell  6 - 12#H
1st RI, Btty. D: Capt. Albert Monroe  6 - 12#N
1st NY, Btty. L: Capt. J.A. Reynolds  6 - 3"R
4th US, Btty. B: Capt. Joseph Campbell  6 - 12#H
Dawn Wednesday, September 17, 1862
The rain, which started falling as a gentle shower shortly after midnight, turned into a downpour by the predawn hours. It rolled away by first light, leaving both armies soaked to their skins and feeling generally irritable. As soon as daylight came, volley fire erupted—the air seethed with missiles.
Appendix D. Animated Sequence of Hooker's Attack: 2nd Overlay (Time 5:45:40)

5:45:40 The Joseph Poffenberger Farm: Hooker designated Gibbon's brigade to lead the attack followed in succession by Phelps', Patrick's, and Hofmann's brigades. Hofmann's brigade is subsequently ordered to remain to guard the batteries from possible attack from the rebels' vicinity Nicodemus Hill. Thompson's battery begins deploying.
Appendix D. Animated Sequence of Hooker's Attack:
3rd Overlay (Time 5:46:00)

5:46:00 The North Woods
Gibbon's brigade advanced at the common time toward Meade's nervous Pennsylvania Reserves, who were posted in the North Woods facing south. The Western regiments formed in columns of divisions (two companies on line). Seymour's 13th PA Reserves has begun moving into the East Woods.
Appendix D. Animated Sequence of Hooker’s Attack: 4th Overlay (Time 5:46:20)

5:46:20 The Dunker Church Ridge
Stephen D. Lee’s Battalion had been in position along the ridge from Dunkard Church to Mumma’s lane since first light. Jordan’s Battery was ordered facing northeast, immediately south of the Smoketown Road—Hagerstown Pike intersection. Parker, Rhat, and Woolfolk went into battery to the right respectively.
Appendix D. Animated Sequence of Hooker's Attack:
6th Overlay (Time 5:47:00)

5:47:08 The Joseph Poffenberger Farm
As Gibbon's brigade stepped off, two
shells had exploded simultaneously in
the thick fog above their center. A third,
probably a percussion shell, had burst in
the rear line of the 6th Wisconsin.
Screams and moans rent the air as
searing iron gouged a tremendous hole
in the unsuspecting ranks.
Appendix D. Animated Sequence of Hooker's Attack: 5th Overlay (Time 5:46:40)

5:46:40: The Joseph Poffenberger Farm
By the time Gibbon's "Iron Brigade" started to move out, Foague's Confederate battery rolled onto the hillcrest south of D. R. Miller's barn. At first, First Sergeant William H. Harris (B Co. 2nd WI) mistook it for one of their own batteries. The scream of incoming shells shattered that illusion.
Appendix D. Animated Sequence of Hooker’s Attack:
7th Overlay (Time 5:47:20)

5:47:20 The North Woods
Phelps’ brigade has started movement and will follow Gibbon’s brigade. Thompson’s battery is passing between Hartsuff’s and Magilton’s brigades and is followed by Matthew’s battery. These two batteries are displacing forward to support Dunce (the lead brigade from Ricketts’ Division.)
Appendix D. Animated Sequence of Hooker's Attack:
8th Overlay (Time 5:47:40)

5:47:40 The North Woods
The Iron Brigade halted momentarily to
realign itself after it passed Joseph
Poffenberger's barn. Major Dawes (6th WI)
distributes Captain Kellog with
Company into the plowed field beyond
the North Woods and Captain
Alexander House with C Company to the
far right beyond the Nicodemus House.

North Woods

C Co, 6th WI

| 6th Wisconsin |
| Joseph Poffenberger Barn |

Nicodemus House
Appendix D. Animated Sequence of Hooker's Attack:
9th Overlay (Time 5:48:00)

The men of the 6th and 2nd Wisconsin regiments seeded and pressed forward. The attacking company moved through the North Woods looking for Confederates. A group of Confederate skirmishers lay in wait at D.H. Miller's farm. Stuart's guns now deliver an unceasing fusillade of sail and steel.
Appendix D. Animated Sequence of Hooker's Attack:
10th Overlay (Time 5:48:20)

5:48:20  D. R. Miller's Farm
As Captain Kellogg and the skirmishers of I Company, 6th Wisconsin started across the plowed field, the Confederate skirmishers around D. R. Miller's Farm opened up. The resulting volley of fire signaled to Gibbon's advancing brigade that the Rebels intended to make a fight of it.
Appendix E. Order of Battle Example: Army of Northern Virginia

To open this window, choose **CSA Order of Battle** from the **View** menu. Each of the shadowed boxes on the card are buttons and, when clicked on, go to a card showing that unit’s order of battle diagram. If you click on the shadowed box representing Jackson’s Corps, the card on the next page will appear in the window. When finished viewing order of battle data, close the window by clicking in the box at the top left corner of the window’s title bar.
Appendix E. Order of Battle Example: Jackson’s Corps

If you click on the shadowed box representing Ewell’s Division, the card on the next page will appear in the window. If you click on the shadowed box representing Jackson’s Corps, the card on the preceding page will appear in the window. When finished viewing order of battle data, close the window by clicking in the box at the top left corner of the window’s title bar.
Appendix E. Order of Battle Example: Ewell’s Division

If you click on the shadowed box representing Trimble’s Brigade, the card on the next page will appear in the window. If you click on the shadowed box representing Ewell’s Division, the card on the preceding page will appear in the window. When finished viewing order of battle data, close the window by clicking in the box at the top left corner of the window’s title bar.
Appendix E. Order of Battle Example: Trimble’s Brigade

This is the lowest level for which order of battle is provided. If you click on the shadowed box representing Trimble’s Brigade, the card on the preceding page will appear in the window. When finished viewing order of battle data, close the window by clicking in the box at the top left corner of the window’s title bar.
Appendix G. Disk Install Set
Notes*


6 Kawasaki, 323.


12 Kawasaki, 153.

*This set of notes only acknowledges sources and ideas used in this paper. Another set of notes is in The Antietam Staff Ride application. It can be accessed by selecting the submenu command Notes from the View menu.
Bibliography*


Catton, Bruce Mr. Lincoln’s Army, Garden City, NY: Doubleday and Co., 1965.


* This bibliography lists the works cited in this paper and in the application The Antietam Staff Ride.


